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Chapter 1: Introduction
1.1 Product Description
Omron Robotics and Safety Technologies, Inc. offers a number of products to complement our
mobile robots.
l

l

A Touchscreen lets a user and an AMR communicate at the AMR's current location.
Call/Door Boxes can be used either as call buttons, to allow a user at a remote location
to request an AMR, as door boxes, to open an automated door so an AMR can pass
through, or as generic digital inputs and outputs.
These are also covered in a separate Call/Door Box Installation Guide.

l

l

l

l

Acuity Localization allows better navigation in very dynamic environments, in which
objects normally used for laser-based navigation are moved or blocked frequently.
The High Accuracy Positioning System uses a sensor on the underside of the AMR to
detect magnetic tape placed at locations, such as a stationary conveyor, where you want
the AMR to achieve particularly accurate positioning.
Side Lasers allow navigation in more challenging areas, where there may be obstacles
at various heights that the AMR must avoid. These are available as an option for users
building their own payload structure.
Rear Facing Laser (LD-250 Model Only) enables obstacle detection in the reverse direction.

1.2 Definitions
Software used with the platform is described in Mobile Support Software on page 23.
Platform

The most basic part of the robot. It includes the chassis, drive assemblies, suspension, wheels,
battery, laser, sonar, an on-board robot core with a built-in gyroscope, software needed to navigate, connectors for interfacing with and powering the payload structure, and the platform
covers.
Payload Structure

Anything you attach to the platform. This could be as simple as a box for holding parts or documents that you want transported, or as complicated as a robotic arm that will be used to pick
up parts to transport. This will often include an Operator interface.
Autonomous Mobile Robot (AMR)

The platform with a payload structure attached to it. This is your complete mobile robot,
which will transport your products, parts, or data.

13732-000 Rev H
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1.3 How Can I Get Help?

Fleet

Two or more AMRs operating in the same workspace.
LD Core

The computer built into the platform. It runs ARAM, SetNetGo, and MARC. The core has all of
the ports for connecting data and power for the AMR‘s sensors and accessories.
EM

This is the combination of software and the appliance that it runs on. It manages a fleet of
AMRs, ensuring that all jobs get processed and that the AMRs do not have traffic problems.

1.3 How Can I Get Help?
Refer to the corporate website or the Omron Robotics and Safety Technologies, Inc. websites:
http://www.ia.omron.com

Related Manuals
This manual covers the installation and setup of peripherals for our mobile robots. There are
additional manuals that cover related topics. The following manuals provide information on
safety, related products, advanced configurations and system specifications.
Table 1-1. Related Manuals
Manual Title

Description

Mobile Robot LD Safety Guide

Describes safety aspect for Omron Robotics and Safety
Technologies, Inc. mobile robots.

LD Platform User's Guide

Describes the operation and maintenance of the LD-60
and LD-90 platforms.

LD-250 User's Guide

Describes the operation and maintenance of the LD-250
platform.

EM2100 Installation Guide

Describes the Enterprise Manager 2100 system, for managing a fleet of AMRs.

Fleet Operations Workspace Core
User's Guide

Describes the FLOW Core software.

12
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Chapter 2: Safety
2.1 What to Do in an Emergency or Abnormal Situation
Press the E-Stop button (a red push-button on a yellow background) and then follow the
internal procedures of your company or organization for an emergency situation. If a fire
occurs, use a type D extinguisher: foam, dry chemical, or CO2 . An ABC dry chemical extinguisher can also be used.

Releasing the Brakes
In case of an emergency or abnormal situation, the AMR can be manually moved. However,
only qualified personnel who have read and understood the robot user manual and the Mobile
Robot LD Safety Guide should manually move the platform. The brakes on the drive wheels
can be released with the brake release button. This requires battery power, and an E-Stop must
be pressed on the robot.

General Hazards
IMPORTANT: The following situations could result in minor injury or damage
to the equipment.
l

Do not ride on the platform.

l

Do not exceed the maximum weight limit.
Payload decreases as slope increases.

l

l

l

l

l

Do not exceed the maximum recommended speed, acceleration, deceleration, or rotation
limits. Refer to the robot user’s guide for specifications.
Do not drop the AMR, run it off a ledge, or otherwise operate it in an irresponsible manner.
Do not allow the AMR to drive through an opening that has an automatic gate/door
unless the door and AMR are configured correctly with the Call/Door Box option. Refer
to the Call/Door Boxes on page 51 for details on the Call/Door Box.
Do not get the AMR wet. Do not expose the AMR to rain or moisture.
Do not continue to run the AMR after hair, yarn, string, or any other items have become
wound around the platform’s axles or wheels.

l

Do not use unauthorized parts.

l

Do not turn on the platform without the antenna in place.

l

Although the lasers used are Class 1 (eye-safe), we recommend you not look into them.

13732-000 Rev H
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2.2 Dangers, Warnings, and Cautions

Releasing an E-Stop

!

CAUTION: PERSONAL INJURY OR PROPERTY DAMAGE RISK
If the AMR’s E-Stop is triggered, ensure that the cause of the E-Stop is resolved,
and all surrounding areas are clear before releasing the E-Stop.

After the E-Stop button has been manually released, the AMR will wait until the motors are
manually enabled.
There are two ways to enable the motors:
l

Use MobilePlanner

l

Press the green ON button on the Operator Panel or the GO button on the Touchscreen.

Once the motors are enabled, the AMR will wait two seconds and then resume commanded
motion, if there is adequate space to maneuver.

2.2 Dangers, Warnings, and Cautions
Alert Levels
There are three levels of alert notation used in our manuals. In descending order of importance, they are:

!

DANGER: Identifies an imminently hazardous situation which, if not
avoided, is likely to result in serious injury, and might result in fatality or
severe property damage.

!

WARNING: Identifies a potentially hazardous situation which, if not avoided,
will result in minor or moderate injury, and might result in serious injury, fatality, or significant property damage.

!

CAUTION: Identifies a potentially hazardous situation which, if not avoided,
might result in minor injury, moderate injury, or property damage.

Alert Icons
The icon that starts each alert can be used to indicate the type of hazard. These will be used
with the appropriate signal word - Danger, Warning, or Caution - to indicate the severity of the
hazard. The text following the signal word will specify what the risk is, and how to avoid it.

14
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Icon

Meaning

!

This is a generic alert icon. Any
specifics on the risk will be in the
text following the signal word.

Icon

Meaning
This identifies a hazardous electrical situation.

Falling Hazards

!

WARNING: PERSONAL INJURY OR PROPERTY DAMAGE RISKThe robot
can cause serious injury to personnel or damage to itself or other equipment if
it drives off of a ledge, such as a loading dock, or down stairs.

Physical Barriers

The edge of a loading dock, the entrance to downward stairs, or any other substantial drop
that is within the AMR’s expected operating area should be physically marked so that the
AMR’s navigation laser will see the barrier, and stop before reaching it. The AMR is designed
to detect objects 190 mm (7.48 inches) tall, so the barrier must be at least that tall. However,
because of variations in floor flatness, we recommend a barrier that is 250 mm tall.
The barrier needs to be continuous at the site, so that the AMR cannot drive around or through
it to the dropoff.
Logical Barriers

You should also use forbidden areas, sectors, or lines with several feet of safety zone (padding)
before the actual dropoff, to ensure the AMR will not try to drive there.
These need to be continuous at the site, so that the AMR can’t plan a path to drive around or
between them to the dropoff.

Special Information
There are several types of notation used to call out special information.
IMPORTANT: Information to ensure safe use of the product.
NOTE: Information for more effective use of the product.
Additional Information: Offers helpful tips, recommendations, and best practices.
Version Information: Information on differences in specifications for different
versions of hardware or software.

2.3 User's Responsibilities
Safe use of the AMR is your responsibility. Safe use includes:
l

Reading the installation and operation instructions, as well as the Mobile Robot
LD Safety Guide, before using the equipment.

13732-000 Rev H
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2.3 User's Responsibilities

l

Ensuring that the environment is suitable for safe operation of the AMR.
If a fleet of AMRs (two or more) is installed, the EM must be used, unless no two AMRs
will ever operate in the same area.

l

l

Ensuring that anyone working with or near an AMR has been adequately trained, and
is following this guide and the Mobile Robot LD Safety Guide for safe AMR operation.
Maintaining the AMRs so that their control and safety functions are working properly.

Electrical Hazards
WARNING: ELECTROCUTION RISK
The docking station has AC power inside. Its covers are not interlocked.

l

Do not use power extension cords with the docking station unless properly rated.

l

Never access the interior of the platform with the charger attached.

l

Immediately disconnect the battery after opening the battery compartment door.
Avoid shorting the terminals of the battery.

l

l

Do not use any charger not supplied by Omron Robotics and Safety Technologies, Inc.
If any liquid is spilled on the AMR, power off the AMR, clean up all possible liquid,
and allow the AMR to air dry thoroughly before restoring power.

Pinch Hazard
Robot Covers (LD-60, LD-90 and LDxxxCT Models Only)

!

CAUTION: PINCH RISK
Strong magnets hold the skins in place, and can pinch you if you are not
careful. Follow the instructions in the Maintenance chapter for handling skins.

Magnetic Field Hazards (LD-60, LD-90 and LDxxxCT Models Only)
Robot Covers

!

16

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers stay back 30 cm (12 inches) from the platform skins, which
are held in place with strong magnets.
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Docking Funnel

!

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers stay back 30 cm (12 inches) from the underside of the platform, which is exposed during certain maintenance procedures when the platform is tipped on its side.

Qualification of Personnel
It is the end-user’s responsibility to ensure that all personnel who will work with or around
mobile robots have attended an appropriate Omron training course and have a working knowledge of the system. The user must provide the necessary additional training for all personnel
who will be working with the system.
As noted in this and the robot user guides, certain procedures should be performed only by
skilled or instructed persons. For a description of the level of qualification, we use the standard
terms:
l

l

Skilled persons have technical knowledge or sufficient experience to enable them to
avoid the dangers, electrical and/or mechanical
Instructed persons are adequately advised or supervised by skilled persons to enable
them to avoid the dangers, electrical and/or mechanical

All personnel must observe industry-prescribed safety practices during the installation, operation, and testing of all electrically-powered equipment.

13732-000 Rev H
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2.4 Environment

IMPORTANT: Before working with the AMR, every entrusted person must confirm that they:
l

l

Have the necessary qualifications
Have received the guides (both this user’s guide, and the Mobile Robot LD Safety
Guide)

l

Have read the guides

l

Understand the guides

l

Will work in the manner specified by the guides

Payload Movement and Transfer
You should actively monitor and confirm the status of AMR payload movement, and transfer
to or from facility equipment.
Payload transfer problems must trigger an AMR E-Stop that prevents the AMR from moving
until an Operator resolves the problem and confirms the system is safe to use.
Your facility should provide an interlock between the AMR and facility equipment.

Multi-AMR Avoidance
When multiple AMRs are operating in the same workspace, they must be connected to a Fleet
Manager Enterprise Manager appliance via WiFi. This helps prevent collisions by sharing
AMRs’ dynamic X, Y, Theta, size, and path-planning information with each other. AMRs then
factor this data into their obstacle avoidance. This is not an interlocked method of preventing
collisions. Ultimately, it is the end-user/integrator's responsibility to provide an interlocked
method of preventing collisions.
NOTE: If two AMRs are approaching each other, they cannot accurately determine each other's size. This is because their lasers scan into each other's recessed
laser slot. Two or more AMRs operating in the same workspace must be managed by the same Fleet Manager.

2.4 Environment
General Environmental Conditions
You must always ensure that the platform‘s operating environment remains safe for the platform. If there are unsafe areas for the platform, physically block those areas off so the platform’s scanning laser will detect the barriers, and the platform will not attempt to drive there.
You can also block off these area using forbidden zones in the MobilePlanner software, but
that should be in addition to physical barriers.

Public Access
The platform is designed for operating in indoor industrial or professional environments. It
must be deployed in a manner that takes into account potential risks to personnel and equipment. The product is not intended for use in uncontrolled areas without risk analysis, for

18
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example, areas open to general public access. Use in such areas may require deployment of
additional safety measures.

Clearance
The platform is designed to operate in an environment that is generally level and has no doors
or other restricted areas too narrow for the AMR. It is the user’s responsibility to ensure that
adequate clearance is maintained on each side of the AMR, so that a person cannot get
trapped between the AMR and a wall or other fixed object. You should consult the applicable
standards for your area. An exception to side clearance can exist at pickup and dropoff locations where the AMR must get close to conveyors or other fixed objects.
The primary direction of travel of the platform is forward. When the platform is turning in
place, with no forward movement, the detection of an obstacle in its path of rotation will not
trigger an obstacle-detection condition.

!

CAUTION: PERSONAL INJURY RISK
Personnel who work with or around the AMR should not stand close to the
AMR when it is turning in place (with no forward motion).

Obstacles
If the AMR will be entering high-traffic areas, the user must take appropriate precautions to
alert people in those areas that a AMR will enter. If the traffic consists of other machines, the
user must adjust the AMR‘s and/or the other machine’s parameters to reduce the risk of a collision.

Safety Scanning Laser Emergency Stop
If an obstacle enters the AMR’s immediate path, the safety scanning laser will trigger an emergency stop. After the AMR has come to a complete stop, it will wait a minimum of two
seconds before resuming commanded motion, with no human intervention necessary.
l

l

If the obstacle is still in the AMR’s path, and there is adequate room, it will first attempt
to safely path plan and maneuver around the obstacle.
If the AMR can’t simply maneuver around the obstacle, it will search for another path
to reach its goal.
If it can’t find another path, it will wait for human intervention.

Safety System Overspeed Faults
A CPLD Channel 1 or 2 fault, is a system fault, reported by independent safety system to the
firmware controlling the robot. A fault signal from the safety system, indicates that the robot is
operating outside of the defined boundaries of safety standards EN1525/ANSI B56.5.
Both referenced standards state, that the speed of motion in directions not covered by the operator detection devices, reverse direction for the LD platform, must be limited to <300 mm/s.
If an LD platform is operated in a manner that exceeds this reverse speed limit, the safety system will generate and report a fault signal. In normal, autonomous operation, this condition
triggers motion controllers to execute a controlled stop. However, if motion is disabled (E-Stop
button is pressed) and the brake release is overridden, the safety system cannot stop the LD
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2.5 Battery Safety

platformsince power to the motors has already been cut off. Once the fault condition is
resolved, the safety system will stop reporting safety fault to the motion controllers, and the
normal start-up process will initiate.
Following table displays overspeed fault conditions.
NOTE: The motion settings such as AbsoluteTransVelMax, that limit maximum
allowable velocities in the robot software (ARAM), have no effect on the safety
system.
Table 2-1. Overspeed Limits for Different LD Models
Gear Ratio Forward Limit (mm/s) i,ii Reverse Limit (mm/s) i

Model
LD-60

30:1

2100

300

LD-90

40:1

1575

225

LD-90x

60:1

1050

150

LD-105CT

40:1

1575

225

LD-130CT

60:1

1050

150

LD-250

32:1

2100

225

i

These values are approximate and represent the upper limit. Maximum speeds should be set
to at least 30-50 mm/s below these values, to prevent erroneous safety overspeed faults.
ii

The forward limits indicate where the safety system will report a fault. These speeds may not
be achievable by the robot under its own power. The max forward speed, should always be set
to the defined maximum (or lower) speed, found in the default configuration shipped with the
robot.

2.5 Battery Safety

!
l

l

CAUTION: BATTERY DAMAGE RISK
After receiving the battery, immediately charge to a full charge to avoid discharging the battery below a usable state, which would require battery replacement.

Never expose the battery to water. If the battery is leaking, submerge in mineral oil and
contact your local Omron Support.
In case of fire, use a type D extinguisher: foam, dry chemical, or CO2 .

Maintenance

Every six months:
l

l

20

Inspect battery for damage or leaks
Place battery on a charger and allow to fully balance (battery shows all solid LEDs
when fully balanced).
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2.6 Intended Use
The AMR is designed to operate in indoor industrial or professional environments. In general,
if a wheelchair can safely and easily navigate the environment, then it is safe for the robot.
Guidelines for safe use:
l

Clean, dry floors — floors that are regularly swept, and routinely kept free of debris and
liquids.
IMPORTANT: Since the robot is not water proof (IP20), floors must be
kept relatively dry, as any dampness can cause the wheels to slip. This
can cause problems for braking as well as navigation. Refer to 13849-2 for
instructions on how to test the robot in non-standard environments.

l

l

Inclines — As specified in the User's guide for a specific model.
Temperature — 5 to 40°C (41 to 104°F), with a recommended humidity range of 5% to
95%, non-condensing.

Non-Intended Use
You must deploy the robot in a manner that takes into account potential risks to personnel
and equipment. The product is not intended for use in uncontrolled areas without risk analysis, for example, areas open to general public access. Use in such areas may require deployment of additional safety measures.
The AMRs are not intended for use in any of the following situations:
l

In hazardous (explosive) atmospheres

l

In the presence of ionizing or non-ionizing radiation

l

In life-support systems

l

In residential installations

l

Where the equipment will be subject to extremes of heat or humidity

l

In mobile, portable, marine, or aircraft systems
NOTE: The gyroscope used to assist in platform navigation requires a stationary environment for optimum accuracy. Therefore, we do not recommend them for use on a ship, train, aircraft, or other moving environment.
IMPORTANT: The instructions for operation, installation, and maintenance given in this guide and the AMR user’s guide must be strictly
observed.

Non-intended use of AMRs can:
l

Cause injury to personnel

l

Damage itself or other equipment

13732-000 Rev H
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2.7 Additional Safety Information

l

Reduce system reliability and performance
IMPORTANT: Since the robot is not water proof (IP20), floors must be
kept relatively dry, as any dampness can cause the wheels to slip. This
can cause problems for braking as well as navigation. Refer to 13849-2 for
instructions on how to test the robot in non-standard environments.

If there is any doubt concerning the application, ask Omron Adept Technologies, Inc. to determine if it is an intended use or not.

Robot Modifications
If the user or integrator makes any changes to the robot, it is their responsibility to ensure that
there are no sharp edges, corners, or protrusions.
Note that any change to the platform can lead to loss in safety or functionality. It is the
responsibility of the user or integrator to ensure that all safety features are operational after
modifications.

2.7 Additional Safety Information
Omron Adept Technologies, Inc. provides other sources for more safety information:

Mobile Robot LD Safety Guide
The Mobile Robot LD Safety Guide provides detailed information on safety for Omron Robotics
and Safety Technologies, Inc. mobile robots. It also gives resources for information on relevant
standards. It ships with each mobile robot.

2.8 Disposal

Dispose of in accordance with applicable regulations.

Customers can contribute to resource conservation and protecting the environment by the
proper disposal of WEEE (Waste Electronics and Electrical Equipment). All electrical and electronic products should be disposed of separately from the municipal waste system via designated collection facilities. For information about disposal of your old equipment, contact your
local Omron support.

22
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Chapter 3: Support Software
3.1 Mobile Support Software
Fleet Operations Workspace Software
The FLOW Core software includes all of the software used for LD platforms and the Fleet Manager appliance.
ARAM

The Advanced Robotics Automation Management software (ARAM) runs on the AMR core. It
operates ranging sensors like the safety scanning laser and sonar, and performs all the highlevel, autonomous robotics functions, including obstacle avoidance, path planning, localization, navigation, and so on, culminating in motion commands to the MARC firmware.
ARAM also controls the battery and light discs, and manages digital and analog I/O, which,
along with AMR power, provide for integration of application-specific sensors and effectors
(user-supplied).
ARAM manages wired and wireless Ethernet communications with offboard software, for
external monitoring, development, and systems coordination, including coordination of a fleet
of AMRs through the optional EM. It also manages integration with other systems, as well as
external monitoring, setup, and control with the MobilePlanner application.
ARAMCentral

ARAMCentral is the software that runs on the EM appliance. This software and the appliance
combined are referred to as the EM.
For a fleet, the ARAMCentral software manages:
l

the map that all AMRs use

l

the configuration that all AMRs use

l

traffic control of the AMRs
This includes multi-robot avoidance, destination, standby, and dock control.

l

queuing of jobs for the AMRs

l

remote I/O, if you are using it

MobilePlanner

In order to have your AMR perform autonomous mobile activities, you need to make a map of
its operating space, and configure its operating parameters. The MobilePlanner software is
used to make this map and perform this configuration.
Refer to the separate Mobile Robot Software Suite User's Guide for details on how to map a
working space and prepare the virtual elements, goals, routes, and tasks for your application.
In particular, refer to:
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Working With Map Files > Editing a Map File > Using the Drawing Tools >
Adding Goals and Docks
The MobilePlanner software requires a license to run. You will need at least one license for
MobilePlanner for each fleet of AMRs. Once you generate a map for an area, it can be shared
between multiple AMRs in one fleet.
MobilePlanner Operator Mode provides limited access to AMRs. See: Fleet Operations Workspace Core User's Guide.
Mobile Autonomous Robot Controller Operating System (MARC)

At the lowest level, a microcontroller running MARC firmware handles the details of AMR
platform mobility, including maintaining the platform’s drive speed and heading, as well as
acquiring sensor readings, such as from the encoders and gyroscope, and managing the platform’s emergency stop systems, bumper, and joystick. The MARC firmware computes and
reports the platform’s odometry (X, Y, and heading) and a variety of other low-level operating
conditions to ARAM.
Touchscreen Support

Whenever the Mobile Software suite is downloaded, it includes support software for the touchscreen.
Call/Door Box Support

Call/Door boxes have one component on the boxes and another on either the EM or on the
single robot, when there is no HAPS.
ARCL Protocol

ARCL is a function of ARAM and ARAMCentral, which is included as part of this suite.
The Advanced Robotics Command Language, or ARCL, is a simple text-based command and
response server for integrating an AMR (or fleet of AMRs) with an external automation system.
ARCL allows you to operate and monitor the AMR, its accessories, and its payload devices
over the network, with or without MobilePlanner.

SetNetGo
The SetNetGo OS runs on the AMR core and EM appliance. It is the host OS in which ARAM
and ARAMCentral run.
The SetNetGo interface in the MobilePlanner software is used for configuring the Ethernet settings for the platform, upgrading software, and performing systems diagnostics, such as
retrieving log files. It can be accessed when connected via the maintenance and management
Ethernet ports, or via wireless Ethernet if enabled.
NOTE: It is possible to connect directly to the SetNetGo OS on an AMR through
a web browser. The main intent of this is to allow your IT support to set up the
network for you, without using MobilePlanner, which requires a license.
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3.2 Tools for Use in the Field
SetNetGo - Managing Software Packages
Software package management is available with SetNetGo 4.4.0 and later. All of the SetNetGo
actions covered here start with the following steps:
1. Access MobilePlanner > SetNetGo.
2. Select Software > Manage Installed Software.
Installing or Upgrading a Software Package

1. Locate and click Install Software: Choose File.
If you are accessing SetNetGo through a browser, this may be Install Software: Browse.
2. Click Upload.
3. If the package is valid, a screen will pop up that indicates that the package was
installed, and an OK button will be shown. (If the package was corrupted or not compatible, then a message will be displayed to communicate that.)
A list of each of the components just installed or upgraded will be displayed.
l

l

For a new install, when you click OK, the application listing will be refreshed,
showing the new package.
For an upgrade, when you click OK, the application listing will be refreshed,
showing the original list but with updated version information for the newlyinstalled software package.

Removing a Software Package

1. Locate the package name for the listing.
2. Click the listing to expand the view.
3. Click Uninstall.
4. You will be prompted for confirmation.
Click OK to continue.
5. Another pop-up will be displayed giving the status of the process (success or fail).
Verifying the Status, Viewing the Change Log, and Viewing Log Output

These actions apply to an executable package. You can verify the version and current execution status of a package.
1. Locate the package name from the listing.
2. Click the listing to expand the view.
3. You will be presented with a button to Enable or Disable the execution of the package,
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and a button to view the log.
4. In addition, you will be presented with links to view the release notes or the latest log
file, both of which will be displayed in an overlay.
Enabling or Disabling an Executable Package

You can disable or re-enable the execution of individual packages, while still leaving them
installed.
1. Locate the package name from the listing.
2. Click the listing to expand the view.
3. Click Enable or Disable. (The default state for enabled vs. disabled is controlled by each
individual package.)
The same button is used to disable or re-enable the package.
4. Click OK to confirm that you wish to change.
5. If disabled, the package will be stopped, and will no longer be started at power-on.
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The touchscreen provides a means for Operators to interact with an AMR wherever the AMR
is. This can be used by the Operator to:
l

check the status of the AMR

l

enter the next goals for the AMR

l

pause or release the AMR

In some systems, the touchscreen will come incorporated as part of an AMR, so there will be
no installation required by the user. You may still need to configure its behavior with Configuration on page 32, and the Operation section will still apply.
The touchscreen is also offered as a standalone product, for users who want to incorporate the
touchscreen into their own LD platform-based AMR.

4.1 Installation
Components
The standalone touchscreen kit includes:
l

Touchscreen with attached bracket

l

Power supply (DC/DC converter) with bracket

l

Power cable, from core to power supply

l

Power cable, from power supply to touchscreen

l

Ethernet cable, between touchscreen and core

l

Gasket, between touchscreen and AMR mounting surface
This protects the touchscreen from vibrations of the AMR.

l

Spacers, to prevent the touchscreen from being pressed too hard into the gasket

l

Fleet Operations Workspace software

Software Installation
The Fleet Operations Workspace software includes support for the touchscreen. This software
needs to be installed before any of the steps in Configuration are performed.
When you purchase an Omron Robotics and Safety Technologies, Inc. AMR, this software suite
will be pre-loaded on it. It can be updated using the SetNetGo OS. See SetNetGo - Managing
Software Packages on page 25.
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Mounting
If the touchscreen isn’t pre-installed, the placement of the touchscreen on the AMR is up to the
customer. In most cases it will be placed near the top of the payload structure, so an Operator
will have easy access to it. The touchscreen has a bracket, with four mounting holes. The
dimensions are shown in the following figure.
NOTE: The touchscreen electronics need to be protected, so the mounting surface needs a cutout that will accept the touchscreen. Do not surface-mount.
CAUTION: The touchscreen glass is fragile. Take care not to flex the touchscreen in any way, and to protect the screen from impact.

!

Mounting Surface Cutout

The mounting surface for the touchscreen needs a cutout large enough for the screen to be
viewed. The four mounting points can either be thru holes, in which case the mounting bolts
will be visible from the outside of the AMR, or you can weld standoffs to the inside of the
mounting surface, to conceal the mounting hardware.
CAUTION: The touchscreen is not centered, horizontally, in the bracket it
comes with. If you are installing the touchscreen yourself, you will need to
account for this, or there will be a small gap at the right side of the screen. See
the following figures.

!
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Figure 4-1 Mounting Dimensions for the Touchscreen, (A) Through Hole (units are mm (inches))
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Figure 4-2 Front of Touchscreen with Bracket
Standoffs/Spacers

Standoffs or spacers need to be used between the mounting bracket and the inside surface of
the payload structure, where the touchscreen is being mounted. You can either use the supplied spacers and thru-holes to mount the screen, or you can weld user-supplied standoffs to
the inside of the payload structure surface, in which case the screw heads would not be visible
from the outside.

!
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WARNING: Use standoffs or spacers to prevent pressing the touchscreen too
hard against the mounting surface. Excess pressure can cause delayed, incorrect, or no response when the touchscreen is touched, or possibly break the
screen’s glass. The standoffs ensure that the gasket is compressed, but the
touchscreen is not stressed. See the following figure.
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Figure 4-3 Standoffs/Spacers for Mounting the Touchscreen (Welded Shown) (units are mm (inches))
Key

Meaning

Key

Meaning

A

Top View

E

Optional Through Hole for Mounting from the
Front

B

Mounting Screws

F

Thick Foam Tape Gasket around Inside of Panel
Opening

C

Standoff

G

Recommended Touchscreen Mounting

D

Threaded Standoff on Inside of
Panel

H

Front View

1. Install the gasket between the touchscreen and the inside of the payload structure surface.
Line up the gasket with the hole in the payload structure surface, so the gasket aligns
with the screen cutout.
2. Attach the touchscreen to the inside surface of the payload structure.
If the mounting standoffs are welded to the inside of the payload structure, use four M4
x 8 mm (0.31 in.) screws to attach the touchscreen bracket. Use a threadlocker, such as
Loctite 222.
If you are using thru holes, you will have to determine the length of bolt needed to go
through the mounting surface, spacer, bracket, and into the nut. Use either nylock nuts
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or a threadlocker, such as Loctite 222. Unthreaded spacers are provided for this method
of mounting.
3. Mount the power supply bracket to existing holes in the top of the platform (payload
bay).
Two holes in the bracket secure the bracket to the platform, two other holes in the
bracket line up with holes in the power supply.
See the following figure.
2 x Ø 5.51 (0.22)
97.64 (3.84)
2 x 92.71 (3.65)
90.65 (3.57)
83.01 (3.27)

2 x Ø 3.99 (0.16)
77.98 (3.07)

77.75
(3.06)

11.25
(0.44)

7.65 (0.3)
2 x 9.65 (0.38)
14.63 (0.58)

5 (0.197)

0

0

53.29 (2.1)

0

2 x 61.47 (1.42)
2 x 30.99 (1.22)
2 x 26.01 (1.02)
2 x 21.01 (0.83)
2 x 16 (0.63)

21.29 (0.84)
0
2 x 16.26 (0.64)
2 x 15.29 (0.6)

Figure 4-4 Power Supply Mounting Bracket Dimensions (units are mm (inches))

Connections
These connections should be made after the mounting procedure is completed.
1. Connect the 5 VDC power cord from the power supply to the touchscreen.
2. Connect an Ethernet cable between the platform core, User LAN port, and the left Ethernet port on the touchscreen. See the following figure.

7.6

7.6
(0.30)

(0.30)
20
(0.79)

B

C

20
(0.79)

A
Figure 4-5 Connections on the Touchscreen (units are mm (inches))
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Key

Meaning

A

Power

B

Ethernet to User LAN on Core

Key

Meaning

C

Do Not Use

4.2 Setup
NOTE: After making and saving changes within User LAN Ethernet Settings,
the robot has to be power-cycled for those changes to take effect. If the only
change is to enable DHCP, then the robot does not have to be power-cycled.
In the MobilePlanner software, select:
MobilePlanner > SetNetGo
Network > User LAN Ethernet
Ensure that:
l

the IP address subnet doesn’t conflict with the Wireless Ethernet IP subnet

l

Interface mode is set to Accessory

l

DHCP Server for Accessories is set to Enable

l

DHCP IP Range is large enough to provide IP addresses for all connected devices

Figure 4-6 Accessory and DHCP Server for Accessories Enabled

4.3 Configuration
You configure the touchscreen's appearance and behavior with the MobilePlanner software.
The tasks include what mode is used, setting up goals for relocalization, and specifying a custom screen logo and the language to be used for the display.

Operating Modes
Specify the touchscreen mode: either Choose Dropoff or Patrol Route.

32

l

Choose Dropoff mode allows the Operator to input the next dropoff goals.

l

Patrol Route mode simply drives around a specific route. The AMR will have goals that
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it stops at, but the Operator will not be able to alter the order of those goals.
For Choose Dropoff, you specify how many dropoff buttons there will be, and how each button
is labeled, as well as the goal on the AMR's map that gets associated with each button.
For Patrol Route, you specify the name of the route and whether to start the patrol on bootup.
The route will include whatever goals the AMR will stop at, and how long it will wait at each
specific goal.
These parameters are accessed from:
MobilePlanner > Config, then Robot Interface > Touchscreen
Select either Choose Dropoff or Patrol Route with the Pages > MainPage parameter, which has
a dropdown selection box.

Choose Dropoff Mode
The following parameters only apply to the Choose Dropoff mode.
Dropoff Priority

This is accessed under Pages > ChooseDropoffPage.
You can enable high-priority dropoffs, which will be serviced before normal-priority dropoffs.
The Operator can specify that a goal is high-priority when it is being selected for the upcoming
dropoff.
AllowHighPriorityDropoffs
This allows some dropoffs to be specified as high-priority. This is enabled by
default, and you can disable or re-enable it in the MobilePlanner software.
HighDropoffPriority
This is the priority assigned to any dropoff that is specified as high-priority.
Higher priority jobs will be serviced before lower-priority jobs by the queuing
manager. This has no effect if AllowHighPriorityDropoffs is disabled.
Dropoff Buttons

This is accessed under Pages > ChooseDropoffPage.
DropoffButtonCount
This specifies the total number of buttons that will be available on the touchscreen page. You can scroll the page to see other buttons, if all of the buttons cannot be displayed at once.
DropoffButtonx
There will be a DropoffButton1 through DropoffButtonx, where x = DropoffButtonCount. Each contains the two following parameters:
GoalName
This is a combo box that lists all of the goals that have been created
on the map. Select the map goal to be serviced when this dropoff
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button is pressed.
NOTE: A goal can have a wait time associated with
it, to give an Operator time to load or unload the
AMR. This is configured, in the map, using the
MobilePlanner software.
You can eliminate a button from the screen by making GoalName
blank. The other buttons will fill in, so there will be no blank spaces
in the screen.
ButtonLabel
This is the text label displayed on the dropoff button. If empty, the
GoalName is displayed.

Patrol Route Mode
The following parameters only apply to the Patrol Route mode.
In this mode you need to specify the name of the Patrol Route that the AMR will patrol. The
route needs to have already been set up using the MobilePlanner software. You also need to
specify if the AMR will start its patrol automatically, or if it requires an Operator to press Go.
Select Pages > PatrolRoutePage
l

l

In RouteName, enter the route to be patrolled.
Check AutoStartRoute for the AMR to start its patrol as soon as the Patrol Route screen
is displayed (the AMR has finished booting).

Localization Goals
You need to configure at least one localization goal. You can configure more if you want. A localization goal is needed to relocalize a lost robot from the touchscreen.
Each localization goal should have:
l

a heading
The AMR will need to be aligned with the heading when relocalizing.
This applies to both laser and Acuity localization.

l

mapped features that don’t change much
Things that get moved frequently, such as pallets, chairs, or carts do not make good
mapped features, because the map will not match what the AMR is seeing.

l

mapped features that don’t get blocked
If a mapped wall is often used for stacking boxes or storing carts, the AMR may have
trouble seeing the wall behind those objects.

l

multiple visible lights, when using Acuity localization
The more lights the AMR can see, the better.

l

34

a high localization score
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This represents the percent of readings that the AMR currently sees that match the features on its map.
NOTE: Localization goals do not have to be dedicated to localization - they can
also be used as normal goals for regular use.
In MobilePlanner, select:
Config > Robot Interface > Touchscreen
From there, use ChooseLocalizationPage to set LocalizationButtonCount to the number of localization goals you want, and then specify the GoalName and ButtonLabel for each.

Figure 4-7 Localization Goal Parameters

Screen Logo
In MobilePlanner, select
Config > Robot Interface > Touchscreen
From there, use Style/Appearance.
A logo is displayed in the upper-left corner of the touchscreen. The default logo is Omron, as
shown in the following figure.
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Figure 4-8 Sample Touchscreen, with Logo, in Choose Dropoff Mode
You can customize this with a logo of your choosing using the following steps:
1. Upload a PNG image file to the AMR using the MobilePlanner software:
File > Download/Upload
2. Open the AMR Configuration window and choose:
Robot Interface > Touchscreen
3. Edit the SmallLogo parameter.
a. Click the file-select button to open the file chooser.
b. Select the newly-uploaded file.
c. Click Open.
4. Click Save, to save the configuration.
NOTE: If the SmallLogo field is left blank, the default Omron logo will be displayed.
NOTE: If a different version of the same file name is uploaded to the AMR, you
will need to power cycle the AMR to see the change.
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Contact Information

Figure 4-9 Help Screen, with Contact Information
Help shows information on the installed software and contact information.
NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software.
In MobilePlanner > Config:
l

Robot Interface > Touchscreen > ContactInformation

l

Check the ShowContactPage check box.

l

Enter appropriate information in ContactName and the fields following it.

Setting Screensaver
In MobilePlanner, select
Config > Robot Interface > Touchscreen
From there, use Screensaver.
If the AMR is in motion when the screensaver comes on, it will use the Busy icon, and display
a status message (where it’s going). If the AMR is not in motion, it will display the Available
icon. The rounded rectangle, icon, and any text inside the rectangle will move around the
touchscreen display area.
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Screensaver Enabled

This is a checkbox that determines whether a screensaver is displayed when the touchscreen is
inactive. Checking the box enables the screensaver.
TimeoutSeconds

This is the number of seconds that will elapse before the screensaver is turned on. This has no
effect if the Screensaver Enabled box is not checked. The range is 1 - 999 seconds.
StayOnTouch

This is a checkbox that determines if touching the screensaver has the same effect as touching
Stay. If this is checked, the robot will stay when the screensaver is touched.

Setting Display Language
You can select what language is used for the display from a dropdown box in the MobilePlanner software.
NOTE: Some messages from the AMR will be in English, regardless of the language set here. These include status and mode messages.
From MobilePlanner, select:
Config > Robot Interface > Language/Location
Select RobotLanguage, which has a dropdown selection box.
This parameter is not touchscreen-specific, so it may affect other displays that involve written
language. As of this writing, only the touchscreen is affected. This parameter does not affect
synthesized speech.

4.4 Operation
Screen Initialization
When first powered up, the bottom of the touchscreen will display its boot status.
1. Initializing robot core connection...
NOTE: This may take a minute or two to initialize.
2. Initializing touchscreen software...
3. Connecting to the robot core...
4. Downloading data from the robot core...
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Figure 4-10 Screen Initialization Status Display
After initialization, either the Choose Dropoff or Patrol Route screen will be displayed.

Screen Top Bar
The top of the screen shows basic AMR information. This includes a bar graph indicating the
WiFi signal strength, the name of the AMR, and the battery state of charge. If the AMR is connected to an EM, it will also be specified here.

Left Screen Pane
The screen logo is displayed in the upper part of the left pane. This doesn’t change, regardless
of the mode you are in.
Below the screen logo, the AMR status is displayed, first graphically, and below that, in text.

Figure 4-11 Screenshot Showing Top Bar and Left, Right, and Center Panes
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Figure 4-12 AMR Status Icons
NOTE: The Busy icon may also include an arrow pointing down, indicating a
pickup, an arrow pointing up, indicating it is doing a dropoff, or an exclamation
mark, indicating an alert condition. Figure 4-8 shows a dropoff.
The bottom of the left side of the touchscreen provides a Stay button, to delay the departure of
the AMR, and a count-down timer, indicating when the AMR will depart.
Each press of the Stay button adds 1 minute to the time the AMR will wait before continuing
to its next goal.
l

l

If you press Stay while the AMR is stopped, it will add 1 minute to the time the AMR is
scheduled to wait before continuing to its next goal.
If you press Stay while the AMR is moving, it will stop, and stay for 1 minute.
NOTE: The Stay count-down timer can be zeroed at any time by pressing Go at
the bottom of the center pane.

The screensaver can be set up to behave the same way the Stay button does, so that pressing
the screensaver adds 1 minute to the time the AMR will wait.

Right Screen Pane
The right side of the touchscreen displays Home, Dropoffs, Status, and Help tabs. Pressing one
of these tabs changes the context of the center pane.
The Dropoffs tab is not displayed in Patrol Route mode.
l
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The Home tab is used to switch the center pane to show the AMR’s current mission. If
an error condition exists, such as the AMR overheating or being lost, the software will
automatically select the Home tab. See the following figure.
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Figure 4-13 Payload Alert, Displayed from the Home Tab
The preceding screen will not be displayed unless the robot configuration has been set
up in the MobilePlanner software:
Config > Robot Physical > Payload > NumSlots
This must be set to a positive value, i.e. the number of payload slots.
Config > Robot Interface > Payload Present Messages and Behavior
l

l

l

The AlertWhenPayloadNeededForDropoff must be checked.
The PayloadNeededForDropoffShortDescription must have a value. In this case,
the value is “Payload Needed”, which is displayed in the screen’s left pane.
The PayloadNeededForDropoffLongDescription must have a value. In this case,
the value is “The robot has a destination but does not have a payload. Please
load an item or cancel the dropoff.” This will be displayed in the screen’s center
pane.
NOTE: The payload parameter section will not be displayed
unless the payload slots at the top of the Payload Present Messages
and Behavior are set to a non-zero value.

The Home screen also has an entry for relocalizing a lost robot from the touchscreen.
See Relocalization on page 45.
When you select Home from the right pane tabs (rather than when the software
switches to Home), the center pane will display information about the robot's current
mission, such as the job details or the current route task.
l

Dropoffs (Choose Dropoff mode only) shows the available goals, giving the Operator the
ability to choose the next goals, and shows the status of the robot with respect to the
goals it has been assigned.
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In Patrol mode, this option isn’t displayed.
l

After pressing the Status tab, you will be given a choice of either Alerts, Robot, I/O, or
Peripherals (which accesses screen-cleaning mode).
The number of alert messages that are available for viewing is indicated by a number in
a red circle on the Status button. See the preceding figure.

Figure 4-14 Status Tab and Sub-menu
o

Alerts shows an abbreviated list of all active alert messages.
Touching on a specific message will display that full message.

o

Robot shows robot status, such as the IP address, what it is currently doing, and
its mode.
Position Details, within the Robot Status screen, shows the robot’s position, heading, velocity, and localization score.

o
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I/O will display any of the Core Digital Inputs / Outputs that have been configured as a “custom” type.
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Figure 4-15 Status > I/O Screen (Top Inputs are not shown in this example)
o

l

Peripherals > Touchscreen allows you to lock the touchscreen, so that you can
clean the screen without it interpreting that as input. The screen stays locked for
one minute, and then returns to normal function.

Help shows information on the installed software and contact information.
NOTE: No contact information will be displayed unless it is set up in the
MobilePlanner software.

Figure 4-16 Help > Contact Information
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Help also provides access the Replay Recorder page, which lets you record data for later playback (generally used for troubleshooting).
Replay Recorder

The replay recorder will record data for troubleshooting. Once the start page is opened, you
just click Start. When you are done recording, click Stop. The Duration and Replay File fields
are filled in by the recorder.
After the recording is completed, you will need to use the MobilePlanner software to download
the file generated.

Figure 4-17 Replay Recorder Start Page
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Figure 4-18 Replay Recorder, After Clicking Stop

Center Pane
The content of the center pane changes depending on what has been selected from the right
pane. The bottom of the center pane will almost always have a Go button, to zero the Stay
count-down timer, and tell the AMR to proceed to its next goal.

Relocalization
The touchscreen gives you a way to relocalize the AMR if it becomes lost. Before you can do
that, you need to have set up at least one localization goal, with a heading, at which the AMR
can localize. You can set up multiple such goals, if you like. See Localization Goals on page
34.
If the AMR becomes lost, the touchscreen will automatically select the Home tab (from the
right pane), and display a message indicating that the AMR is lost. It will also offer an option
to Recover.
1. Press Recover.
2. Follow the on-screen instructions.
You will be instructed to manually move the AMR to a localization goal, and then tell
the software which goal you moved the AMR to.

Dropoffs (Choose Dropoff Mode only)
In this mode, the touchscreen communicates with the queuing manager, which then communicates with the AMR.
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4.4 Operation

NOTE: Until the queuing manager has been enabled, the touchscreen will not
display any of the dropoff goal buttons. Refer to the Mobile Robot Software Suite
User's Guide.
In this mode, the center of the screen displays touch-sensitive dropoff buttons, indicating the
goals associated with them. If there are more buttons than can be displayed at once, a sliver of
the next row of buttons is shown, to indicate their existence. See Figure 4-8
Navigation of the center pane, when there are more buttons than can be displayed at one time,
is done by touching the screen, between buttons, and dragging the pane up or down.
The color and border of a dropoff button indicate the status of the associated job.
l

Ready (not selected) will be medium blue, with no border.

l

Planned (selected, Go has not been pressed) will be dark blue, with no border.
At this stage, you can de-select the goal or change its priority.

l

Requested (brief state between Go being pressed and job being scheduled by the queuing
manager) will have the same appearance as Planned.
At this stage, the selected dropoff goals have been sent to the queuing manager. The
goal can be canceled, and the priority can be changed.

l

Pending (scheduled by the queuing manager) will be dark blue with a medium blue border.
At this stage, the job for this goal can be canceled, and the job priority can be changed.

l

In Progress (AMR is en route to this goal) will be dark blue with a green border.
At this stage, the job for this goal can be canceled, but the priority cannot be changed.

l

Interrupted (such as Stay being pressed or a fault occurring) will be dark blue with an
orange border.
At this stage, the job for this goal can be canceled, but the priority cannot be changed.

l

Completed or Canceled dropoff buttons will revert to Ready status.

Operators can use this pane for entering the goals where they want the AMR to go for
dropoffs, after leaving its current location.
Pressing a dropoff button and then Go requests that the AMR be sent to that goal. Pressing several buttons in sequence, followed by pressing Go, requests that the AMR be sent to all of those
goals, in the order in which the dropoff buttons were pressed. The order may be altered by
assigning high-priority to any of the goals.
The number of buttons, the content of each button, and the goal associated with each button is
configured with the MobilePlanner software.
l

l

l
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Goals will be serviced by the AMR in the order in which you press their buttons.
The selected dropoff goals are not sent to the queuing manager until you press Go. After
being received by the queuing manager, each goal is considered to be a job.
Pressing a Planned (selected) dropoff button will de-select it, without affecting other
Planned dropoff buttons.
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Simply pressing a Pending or In-Progress goal button will not affect the associated job.
An explicit Cancel is required to cancel a job in either of those states.
l

Buttons will change appearance when you select/de-select them, change their priority,
when the job is received by the queuing manager, when an AMR is on its way to the
button's goal, and when the job is completed (and AMR dismissed).

Cancel Request (X)

When a dropoff button has a blue or green border, meaning its job is Pending or In Progress,
the Operator can touch the button and a Cancel pop-up button (X) will be displayed on the button. Touching that pop-up will cancel the job for that goal. This does not affect any other jobs.
See Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups on page 47.
High Priority (!)

If you touch-and-hold the dropoff button for a goal that is planned or requested, or simply
touch the button for a job that is pending, a High-Priority pop-up button (!) is displayed. Touching this pop-up will toggle the priority for the goal or job between high and normal priority.
See the following graphic.
When a job is assigned high priority, its dropoff button will display a visible high-priority
indicator (!). A high-priority job will be serviced before all normal-priority jobs, even if those
jobs were entered at an earlier time.
This means that if you press Goal1, then Goal2+HighPriority, then Goal3, they will be serviced
in this order: Goal2, Goal1, Goal3.
If you de-select a high-priority dropoff button, and then re-select it, it will appear as normal priority (the high-priority flag is not persistent).
NOTE: Changing a high-priority dropoff button or job to normal priority will
move that button or job to the end of the queue, so it will be serviced last.

Figure 4-19 Touchscreen Dropoff Goals Page, with Cancel and Hi-Priority Pop-ups
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4.4 Operation

Figure 4-20 Touchscreen Dropoff Goals Page, with Stay and Count-down Timer
Stay Button

If the AMR is en route to a goal when Stay is pressed, that goal’s button will turn dark blue
with an orange border.
If the AMR has entered a wait task associated with a goal or job, pressing Stay merely extends
that wait, and the button border stays green. (The job isn’t interrupted from the queuing manager’s perspective, the wait task has just been prolonged.)
Go Button

The bottom of the center pane, in Dropoffs and user-selected Home mode, is a Go button. This
zeroes the countdown timer, and causes the AMR to immediately proceed to its next goal. This
can be used in conjunction with the Stay button to pause the AMR, and give the Operator
more time to load or unload the payload.

Patrol Route Mode
The AMR does not communicate with the queuing manager in this mode.
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Figure 4-21 Touchscreen, Patrol Route Page, in Stay Mode

4.5 Specifications
Touchscreen
Feature

Specification

Touch Panel

PCAP touch sensor, 5 simultaneous touches, black bordered cover lens

TFT Display

TFT LCD panel, 18/24 bit RGB parallel interface.
7.0 in. WVGA - Wide Viewing Angles, 5-Touch

Backlight

Constant current LED supply

Power Input

5 VDC supplied through power connector

Power
6.5 W maximum
Consumption
Operating
Temperature

0° to 60° C

Power Supply
MeanWell SD-15B-05
15 W, 18-36 V input, 5 V output
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4.5 Specifications

Output

Input

Protection

Environment

50

DC Voltage

5V

Rated Current

3A

Current Range

0 -3 A

Rated Power

15 W

Voltage Adj. Range

4.75 - 5.5 VDC

Voltage Tolerance

± 2.0%

Voltage Range

18 - 36 VCD

DC Current (Typ.)

1.9 A/12 VDC

Overload

105 - 160% rated output power

Over-Voltage

5.75 - 6.75 V

Working Temp.

-10° to +60° C

Working Humidity

20 - 90% non-condensing

Storage Temp.

-20° to +85° C

Storage Humidity

10 - 95% non-condensing

LD Platform Peripherals Guide

13732-000 Rev H

Chapter 5: Call/Door Boxes
A call/door box can be used either as a call button or as a door box. A door box can be used for
generic I/O, with which the AMRs can interact. Both boxes use the same hardware and software. The differences are covered in this chapter.
Refer also to the EM User`s Guide, which covers the EM hardware and software required for
managing multiple AMRs (a fleet), and the Mobile Robot Software Suite User's Guide, which covers software needed for configuring and managing a fleet or an AMR.

B

A
Figure 5-1 Call/Door Box, (A) Red LED, and (B) Speaker Hole
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5.1 Overview

5.1 Overview
When a call/door box is configured for requesting an AMR, it will be referred to as a call button. When it is configured for requesting that a door be opened or for generic I/O, it will be
referred to as a door box.
Call/Door Boxes use WiFi or hard-wired Ethernet to communicate with the EM for a fleet. They
can use WiFi with a single-AMR installation. Except for a single-AMR installation, WiFi is
also required for direct communication with the AMRs. A laptop can be temporarily hardwired to a single AMR for setup.
The software supports up to 40 call/door boxes.
Each call/door box supports both wired and wireless communication.

Call Buttons
Call Buttons are used to issue a request for an AMR to go to the call button's goal. Each call
button will have an associated goal that an AMR can be sent to. There may be multiple call
buttons, even in an installation where there is only one AMR.
NOTE: Call buttons cannot be used for AMRs that are in Patrol Route mode.

Door Boxes
Door Boxes are used to issue a request to open a closed door that is equipped with a door actuator, so an AMR can pass through it.
One door box is required for each door to be opened.
NOTE: It is also possible to use a door box as two generic digital inputs and
two generic digital outputs. In this case, the box would not be used to open a
door.

Fleet Behavior
The EM system consists of an EM appliance running the Mobile Robot Software Suite.
l

If two or more AMRs are used in the same workspace, they are considered a fleet.

l

All AMRs in a fleet will communicate all information via WiFi to the EM.
In no case will an AMR in a fleet bypass the EM system when interacting with information from a call/door box.

l

All fleets require the Mobile Robot Software Suite running on an EM appliance.

l

All fleets require the EM license.

Communication
All call/door boxes will end up communicating with either an EM appliance or a single AMR.
AMRs in a fleet will communicate with the queuing manager on the EM appliance. In most
cases, there will be steps in between, such as a router or WiFi access point.
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Ethernet (WiFi or Wired)

These call/door boxes use wired or wireless Ethernet to communicate through a router or
access point, and then to the AMR, for a single-AMR installation, or the EM appliance for a
fleet. Ethernet call/door boxes require either a wireless and/or wired Ethernet infrastructure.
External I/O

All call/door boxes have two external inputs and outputs. Other than a door box, which uses
one of its outputs to signal the door actuator, use of the external I/O is optional.
Call Buttons

The two inputs for call buttons are treated exactly the same as a button press. This behavior
cannot be changed. This enables you to use an external trigger, such as a signal from a conveyor sensor, to call for an AMR to be sent to the associated goal. You could also use it to add
one or two other call buttons, of your own choosing. Note that all inputs for any given call button would be calling an AMR to the same goal.
Call button I/O is turned on with the MobilePlanner parameter AutoIoEnable, which is only
displayed when the Show Expert + Parameters box is checked.
The two outputs can be wired to an external device, such as a beeper or light, to signal the
status of the job. Automatic control of the outputs is configured with the parameter AutoIo,
which can be set to Neither, Output1, Output2, or Both (the default).
If an output is configured for Automatic control, the following table shows the behavior for the
output:
Job Status
Idle or Cancel

Output1
OFF

Output2
OFF

Request Active ON

OFF

Robot Arrived

ON, 1 sec. minimum

ON

Door Boxes

There are two external inputs and two external outputs on each door box, which can be configured using the MobilePlanner software. Normally, Output1 will be wired directly to the door
actuator, though it is possible to use both outputs for other things. I/O use is up to the user.

5.2 Components
Call/Door Box
This communicates with the EM for a fleet or the AMR for a single-AMR installation, and
either the user at the call button location or a door actuator that can physically open a door.
Each box is mounted to a wall with one or two wall mounts, which can be used as spacers
depending on the amount of room you need behind the box for electrical connections.
The front of a call/door box has a lighted push-button, eight distance lights, and a red status
LED. See Call/Door Button Lights on page 78.
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5.2 Components

Ethernet Port

The Ethernet port, on the back of the call/door box, is used to access the built-in web interface
on the box. The port is shown circled near the top of the following figure.

Figure 5-2 Back of Call/Door Box, Showing Ethernet and VDC
Power Supply and Connector

The call/door boxes come with a 12 V power supply, which connects to the back of the call/door box. The connection is circled, near the bottom of the preceding figure.
The power supply connector can only be inserted one way into the back of the box.

Figure 5-3 Power Supply Connector
DIP Switch

A DIP switch, with four positions, is accessible from the back of the call/door box.

54

LD Platform Peripherals Guide

13732-000 Rev H

Chapter 5: Call/Door Boxes

D

B

C

DC_IN
A

DIN_2+
DIN_2DIN_1+
DIN_1DOUT_2+
DOUT_2DOUT_1+
DOUT_1-

Figure 5-4 Call/Door Box DIP Switch and Connectors, (A) Ground, (B) OFF, (C) ON, and (D) DIP
Switch Position Table
The default setting is all positions of the DIP switch set to OFF, meaning Call Button, with
beeper enabled. If you change position 1 (DP1) to ON (Door Box), the lights and push-button
will no longer behave as they do for a Call Button.
Table 5-1. DIP Switch Position Table
Position

Function

OFF

ON

Position 1 (DP1)

Select device type

Call Button

Door Box

Position 2 (DP2)

Reset the device

N/A

Reset to factory defaults

Position 3 (DP3)

Not Used

Not used

Not used

Position 4 (DP4)

Control sound

Sound enabled

Sound muted

Position 2 on the DIP switch resets the LAN and WLAN settings and also provides a means to
access the built-in web interface for configuration.
Position 4 can be turned ON (muted) in situations where audio is not appropriate.

Door Actuator (Door Box only)
This is user-supplied, and must be capable of opening a door at the request of the door box. It
is hard-wired to a door box.
One example of a door actuator is the Falcon 8230 electro-mechanical swing operator.

Ethernet Infrastructure (wired and wireless), AMRs
Due to the variety possible in different installations, no attempt is made in this manual to specify setting up WiFi or other infrastructure.
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5.2 Components

Software
Call/Door Box Software

A
D

B
C
E

L

F

M

G
H

N

K

K

J

J

M

Figure 5-5 Structure of the Call/Door Box Software
Key

Meaning

Key

Meaning

A

User's PC

H

LD platforms

B

MobilePlanner

J

Core

C

EM

K

ARAM

D

User's WMS/MES

L

Call/Door Box (Eth.)

E

ARAMCentral

M

Call/Door Node Software

F

Call/Door Host Software

N

Call/Door Box (WiFi)

G

Access Point

There are two components to the Call/Door box software. One runs on each Call/Door Box. The
other component runs on the EM, if there is one, or on the AMR core, for a single-robot installation. Both are included in the Mobile Robot Software Suite. The software:
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l

Manages discovery and connection to newly discovered call/door boxes

l

Populates the EM configuration with new call/door boxes
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l

Maintains communication with individual call/door boxes

l

Populates and modifies jobs sent from call/door boxes

Mobile Robot Software Suite

This includes the ARAMCentral software that runs on the EM appliance, and is covered in the
Mobile Robot Software Suite User's Guide. The call/door box software components are also
part of the Software Suite.

5.3 Call/Door Box Configuration
A number of configuration tasks need to be performed before the hardware is mounted because
they require access to the back of the call/door boxes, which will not be accessible after the box
is mounted to a wall:
l

Set the DIP switch on each call/door box, if needed.
Refer to DIP Switch on page 54 for DIP switch settings and their effects.

l

Configure various settings on the box through a built-in web interface.
The same web interface is used for configuring wired and wireless call/door boxes.

Setup
1. Connect power to the call/door box.
a. Plug the supplied power supply into a wall outlet.
b. Plug the power connector into the back of the call/door box.
Refer to Figure 5-2 , Figure 5-3 , and Figure 5-4
2. Connect your PC to the Ethernet port on the back of the call/door box.
Use a straight-through Ethernet cable. The port is shown circled near the top of Figure 52
3. If you have not changed the call/door box default IP address (or you have reset it back
to the default), configure your PC to use IP address 1.2.3.1. Refer to Resetting a Call/Door
Box (WiFi or Wired) on page 65 if you need to reset the box.
Set your PC’s subnet mask to 255.255.255.0, which is the default for the call/door box.
a. Start the Network Connections:Local Area Connection dialog for the Ethernet
port:
(Windows) Start > Settings > Network Connections > Local Area Connection
b. Select Properties, and, from its dialog, scroll to and double-click the Internet Protocol (TCP/IP) option. In the Internet Protocol (TCP/IP) Properties dialog, click
both ‘Use the following…’ associated radio buttons to enable them, and then type
in the IP and netmask values.
NOTE: If you have changed the call/door box default IP address, configure your PC to use an IP address that works with the new address.
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5.3 Call/Door Box Configuration

Boot the call/door box, Enable its web interface
NOTE: Simply applying 12 VDC power to the call/door box will boot the box,
but extra steps are required to enable the built-in web interface, which gives you
access to the configuration of the call/door box.
1. Enable the call/door box web interface.
This can be done in either of two different ways.
Using the DIP switch:
a. Remove power from the box.
b. Move Position 2 (DP2) on the DIP switch to ON.
When power is applied, this will reset the LAN and WLAN settings and also
provide a means to access the built-in web interface.
c. Apply power to the box.
NOTE: After changing and storing the settings in the web interface, you
will need to switch the DIP switch position 2 back to OFF and then
power-cycle the call/door box.
Using the push-button:
a. Remove power from the box.
b. Re-apply power to the box.
All the LEDs will come on. The red LED will be on, but not blinking.
c. Wait 60 seconds.
d. Press and hold the button.
If the lights go out before you press the button, you will need to recycle power, to
start the process over.
While pressing the button, all of the lights will go out, indicating that the box
itself has booted, but not the web interface.
e. Continue to hold the button down until all of the lights flash briefly one time,
and them come back on.
This confirms that the box is enabling the web interface.
f. Continue to hold the button down for about 10 more seconds, until all of the
lights go out.
You can then release the button and connect to the web interface.
NOTE: If you release the button before that time, the box will have
booted, but the web interface will not be enabled.
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2. Use a web browser to access the call/door box IP address. If you need to reset this to
1.2.3.4, see DIP Switch on page 54.
a. For the username, enter: admin.
b. The password is the same as the username. Enter: admin.
c. Click Log in.
A status web page will be displayed. Refer to the following figure.

Status Tab

Figure 5-6 Ethernet Status Screen

Network Tab
Select the Network tab in the left pane to access any of the configuration screens. You can navigate to these screens by selecting:
l

Wired (Ethernet) or Wireless (WiFi)
and

l

Interface or Link
and

l

Status or Configuration (or Scan)
If you select Wireless and Link, Scan becomes available in the third row.

These selections are at the top of the center pane in all of these screens. There are a total of
nine screens that you can access through the Network Tab.
NOTE: In the screens that follow, the buttons on the bottom row, which include
Apply Temporary, Test Connection, and Store Permanent, do not appear unless
you have made a change on that screen.
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5.3 Call/Door Box Configuration

Wired (Ethernet) + Interface + Status
This screen shows you the wired network interface status.

Figure 5-7 Wired Interface Status Screen
Wired (Ethernet) + Interface + Configuration
This screen lets you configure the wired network interface.

Figure 5-8 Wired Interface Configuration Screen
1. Enter an IP address for this call/door box.
Each call/door box is a node on the network, and needs its own IP address.
An explicit mask may be entered, but is not required.
2. Click Store Permanent to write the configuration change to flash.
The information panel will reflect the changes you made.
3. Put a temporary label on the front of the call/door box with its IP address.
This will be useful when you need to enter the IP address into MobilePlanner.
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Wired (Ethernet) + Link + Status
This shows the wired link status.

Figure 5-9 Wired Link Status Screen
Wired (Ethernet) + Link + Configuration
This lets you configure the link.

Figure 5-10 Wired Link Configuration Screen
Wireless (WiFi) + Interface + Status
This shows the status of the wireless network interface on the call/door box.

Figure 5-11 Wireless Interface Status Screen
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5.3 Call/Door Box Configuration

Wireless (WiFi) + Interface + Configuration
This screen lets you configure the wireless network interface.

Figure 5-12 Wireless Interface Configuration Screen
1. Change the static IP Address to fit your wireless network.
2. Click Store Permanent to write the configuration change to flash.
The information panel will reflect the changes you made.
3. Put a temporary label on the front of the call/door box with its IP address.
This will be useful when you need to enter the IP address into MobilePlanner.
Wireless (WiFi) + Link + Status
This shows the wireless link status.

Figure 5-13 Wireless Link Status Screen
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Wireless (WiFi) + Link + Configuration
This lets you configure the link.

Figure 5-14 Wireless Link Configuration Screen
Wireless (WiFi) + Link + Scan
This shows a scan of wireless access points within range of the call/door box.

Figure 5-15 Wireless Scan

WLAN Profiles Tab
Use the WLAN Profiles tab, in the left pane, to access the WLAN Profiles page.
You are given the choice of either default_infrastructure or adhoc. Choose default_infrastructure, which will use your access port, rather than establishing a peer-to-peer network. Adhoc is only used for temporary setups, with a very small number of peers.
WLAN Profiles
This lets you select which of the two profiles you want to configure.
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5.3 Call/Door Box Configuration

A

Figure 5-16 WLAN Profiles Selection Screen
Callout

Description

A

Note: Click the 'Enabled' checkbox, and then click 'Default_Infrastructure_Profile', which is a link to the next screen.

WLAN Profiles > Default_Infrastructure_profile
This screen lets you configure the default_infrastructure profile.

Figure 5-17 WLAN Default_Infrastructure Configuration Screen
1. Enter a Network Name (SSID) and Passphrase.
2. Test the connection by clicking Apply Temporary, then Test Connection.
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3. If the connection tests to your satisfaction, click Store Permanent to save the settings to
flash.
NOTE: The Apply Temporary, Test Connection, and Store Permanent buttons will only be displayed if you have made changes to the profile.
The window’s information panel will summarize what you changed.
4. If you enabled the web interface with the DIP switch position 2:
a. After permanently storing the “default_infrastructure_profile”, set DIP switch position 2 to OFF.
b. Power-cycle the call/door box.
5. Wait for at least one minute, then ping to test the wireless connection.

Resetting a Call/Door Box (WiFi or Wired)
1. Remove power from the call/door box.
2. Set the DIP switch position 2 to ON.
Refer to DIP Switch on page 54.
3. Power-on the call/door box.
This will reset the box to factory defaults. DIP switch settings are not affected.
4. Set the DIP switch position 2 back to OFF after the reset, or the box will continue to reset
every time it is powered on.
After resetting, you will need to power-cycle the call/door box.

5.4 Mounting the Hardware
Call/Door Box

A
E

B

F

C
G

D

13732-000 Rev H

LD Platform Peripherals Guide

65

5.4 Mounting the Hardware

Figure 5-18 Call/Door Box Installation Components
Key

Meaning

Key

Meaning

A

Call/Door Box Body

E

Screws to Mount x 4

B

Left Screw Cover

F

Right screw Cover

C

Wall Mount

G

Screws to Wall x 4

D

Screws from Box Body x 4

The call/door box attaches to a wall mount, which is screwed onto a wall. Two wall mounts
can be used if more room is needed for electrical connections. The back of the box has connectors for 12 VDC power, hard-wired Ethernet, and digital I/O.
NOTE: The call/door boxes come with a 12 V power supply, which has a 1.2 m
long cord. The box needs to be mounted close enough to an electric outlet for the
cord to reach it.
1. Attach the wall mount(s) to the wall, using four user-supplied screws.
The hole diameter is 3.5 mm (1/8 in.). The length of the screws depends on the type of
wall and whether you are using one or two wall mounts.
Refer to Dimensions on page 81. For two wall mounts, reverse the mount nearest the
wall, as shown in Figure 5-20 and Figure 5-21
2. Remove the two screw covers from the call/door box.
Press down on the center of each cover, and slide it out, away from the box.
3. Plug the 12 VDC connector into the back of the box body. See Figure 5-4
Plug the 12 V power supply into an electric outlet.

Figure 5-19 VDC Connection on Back of Box Body (Circled)
For a wired connection, plug your network Ethernet cable into the back of the box.
For optional user-supplied I/O connections, attach the I/O wires to the I/O block.
Refer to Call/Door Box DIP Switch and Connectors, (A) Ground, (B) OFF, (C) ON, and
(D) DIP Switch Position Table on page 55.
4. Set the DIP switch, if needed. The default is for a call button, with the beeper enabled. If
that is not what you want, refer to DIP Switch on page 54.
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5. If the box is to be used as a door box, connect wires from Digital Output 1 on the back
of the box to the door actuator.
This output will have to be configured in the MobilePlanner software. See Adding Door
Areas to Your Map on page 73 and Figure 5-4
Both call buttons and door boxes have two external inputs and two external outputs.
The I/O for door boxes can be configured in the MobilePlanner software. The behavior of
the I/O for call buttons is hard-coded. See External I/O on page 53.
6. Attach the box to the wall mount, using four supplied self-tapping screws. See the following figure.

Figure 5-20 Attaching the Call/Door Box to its Mount, Two Wall Mounts Shown
7. Reattach the two screw covers to the box.
Press down on each cover, and slide it toward the center of the box. It will snap into
place.
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5.5 MobilePlanner Configuration

Figure 5-21 Assembled Call/Door Box

5.5 MobilePlanner Configuration
A number of configuration tasks need to be performed after the hardware is installed. All of
these tasks are performed using the MobilePlanner software.

Host Software
The host software component needs to have been loaded onto the EM for a fleet installation or
onto the AMR for a single-AMR installation. It is part of the Mobile Robot Software Suite,
which includes support for the call/door box. The Mobile Robot Software Suite can be
uploaded using the SetNetGo OS 4.0.0 or later. This needs to happen before any of the steps in
the next Configuration section are attempted. See SetNetGo - Managing Software Packages on
page 25.
Factory-installed firmware is maintained by the call/door box host software, if needed. No user
action is required.

Overview of Tasks
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l

Enter the IP address of each Ethernet device.

l

Assign a goal to each call button.

l

Enable the Mobile Call-Button/GPIO software.
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l

l

For call buttons:
o

Configure the parameter BeepSeconds to set how long the node beeps when the
robot arrives. This parameter applies to all call buttons.

o

For a single-AMR installation, enable the Queuing Manager.

For door boxes:
o

Configure the external digital output used to signal the door actuator.
NOTE: Door boxes can be used as two generic digital inputs and
two generic digital outputs, rather than used to trigger a door actuator.

o
l

Add the door-related AMR control features to the map.

Configure any external I/O that you have connected.

Configuring Call/Door Boxes
Each call/door box needs to have its IP address entered in the MobilePlanner software. For call
buttons, you also need to enter a goal and the goal's priority. Fields that are auto-populated or
do not apply will be grayed out, and you will not be able to change them.

Figure 5-22 Entering a Goalname for the Call Button
1. Go to MobilePlanner > Config > Robot Interface, then
2. Call Button and I/O Devices > EthernetDevices > NumEthernetDevices
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Enter the total number of Ethernet call/door boxes.
MobilePlanner will create <NumEthernetDevices> devices, starting with Device1, each
with an IPAddress, Type, and GoalName field.
3. Call Button and I/O Devices > EthernetDevices > Device1
For the following fields:
o

IPAddress : Enter the IP address that you assigned to the box.

o

Type is auto-populated with either CallButton or Door.

o

GoalName (call buttons only)
Enter the name of the associated goal.

o

Priority (call buttons only)
Enter the priority to assign to the associated goal. This field will only be visible if
the Show Expert + Parameters box is checked.
This is an integer value that represents the priority of the pickup request. The
higher the number, the sooner the EM will service the request. The default priority is 10. The range is –2147483648 to 2147483647.

4. Repeat this for all Ethernet call/door boxes, Device2 through Devicex, where x is the
value of NumEthernetDevices.
NOTE: It may be simplest if you install one box at a time, and configure
that. This ensures that you know which box you are dealing with, so you
can assign the appropriate goal, for a call button, or appropriate map
data, for a door box. If you decide to install multiple call buttons or door
boxes before configuring them, refer to Identifying an Installed Call/Door
Box on page 72.
5. Enable the Mobile Call-Button/GPIO software using SetNetGo.
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Figure 5-23 Enabling the GPIO Software
a. Access MobilePlanner > SetNetGo.
b. Select Software > Manage Installed Software.
c. Locate the package name Mobile Call-Button/GPIO Software from the listing.
Click the listing to expand the view.
d. Click the Enable check box.
e. Click OK to confirm that you wish to make the change.
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5.5 MobilePlanner Configuration

Figure 5-24 SetNetGo will Confirm that the Selection was Enabled

Identifying an Installed Call/Door Box
Call Buttons

If a call button does not have a goal, it will display a distinctive light pattern: the top, bottom,
left, and right distance LEDs will be on; the other LEDs will be off.
If the button is pressed and there is no goal assigned, you will be presented with a pop-up notification in the MobilePlanner software:
Device <XX:YY:ZZ> button pressed with no goal assigned.
This can be used if you have installed multiple call buttons, and need to assign their goals.
The pop-up will identify which button was pressed, so you can find the correct items to configure in the MobilePlanner software.
Door Boxes

If you have installed multiple door boxes without adding their Door area data to the map, you
can use the box push-button to identify the box. Pressing the push-button causes a pop-up message to be displayed in the MobilePlanner software, identifying which door box was pressed.
Push-button on door box <XX:YY:ZZ> was pressed.
This ensures that you are setting up the correct door box on the map.

72

LD Platform Peripherals Guide

13732-000 Rev H

Chapter 5: Call/Door Boxes

Setting the Arrival Beep Duration
NOTE: The following parameter will not be visible unless the
Show Expert + Parameters box is checked.
1. Go to MobilePlanner > Config > Robot Interface.
2. Call Button and I/O Devices > BeepSeconds
o

0: the call button will not beep at all.

o

-1: the call button will beep continuously while the AMR is in the arrived state.

o

n: where n is a positive number
The call button will beep for n seconds when the AMR arrives.

The default value is n = 1.

Enabling the Queuing Manager for Single-AMR
1. In MobilePlanner > Config > Robot Operation > Queuing Manager, enable Queuing Manager if you have only a single robot.
A call/door box button press will queue a PICKUP job at the goal associated with the
call/door box.

Figure 5-25 Enabling the Queuing Manager

Adding Door Areas to Your Map
Configuring an Output Signal

An output signal from the door box needs to connect with the door actuator.
NOTE: None of the following parameters will be visible unless the
Show Expert + Parameters box is checked.
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1. Go to MobilePlanner > Config > Robot Interface.
2. External Digital Outputs > Device<5E:CA:03>_Output_1
NOTE: This section (External Digital Outputs) will not be present if there
are no call/door boxes in the system.
o

Alias
Enter a meaningful name, to be used in place of Device<5E:CA:03>_Output_1. If
this has spaces, they will be replaced with ‘-’.

o

Inverted
Check the box for True (enabled) if logical ON is electrically low, or ground, for
this output. Leave unchecked for False if logical ON is electrically high.

o

Count
Select the number of items that trigger this output. For door boxes, set this to 1.

o

Type1
Select “door” from the drop-down for the trigger (value) of this output.

Configuring a Door on the Map

For this configuration, you need to have the following parameters enabled:
1. MobilePlanner > Config > Robot Operation
2. Map Features
o

SingleRobotSector

o

Doors

These are both check boxes (no values are needed).
NOTE: The goals and DoorSwingSector must exist, and the door output must be
configured before you can create a Door area. You will have to estimate where to
place the Door area. See Hints and Tips for Door Areas, Door Goals on page 75.
Decide where the Door area will go on the map, then:
1. Create a Door goal on each side of the door.
These goals need to be clear of where the door will swing when it opens or closes.
a. MobilePlanner > Map > Draw
b. Goal > Door goal
c. Give the Door goal a name (and optional description).
You do not need to change anything in the Parameters: section.

74

LD Platform Peripherals Guide

13732-000 Rev H

Chapter 5: Call/Door Boxes

2. Create a DoorSwingSector on the side of the Door area to which the door swings.
a. MobilePlanner > Map > Draw
b. Advanced Areas > DoorSwingSector
c. Give the sector a name (and optional description).
Use the outline of the sector to specify a safe distance from the door, so the AMR doesn't
get hit by the door opening or closing. Make sure that it includes the entire swing of the
door, and the Door area itself.
You will have to estimate how large to make the DoorSwingSector, because it must be
created before the Door area is added to the map. Add half the length of the AMR to
both the length and width of the DoorSwingSector, to ensure that the AMR will be clear
of the door when it opens or closes.
3. Create a Door area where the physical door is on the map.
a. MobilePlanner > Map > Draw
b. Advanced Areas > Door
c. Select the two Door goals in the FirstEnter and SecondEnter fields drop-downs.
d. Enter the output that you configured previously for this door in DoorOutput.
If you entered an Alias for that output, enter it here.
e. Enter a value, in seconds, in WaitTime, to specify how long the AMR should
wait at an entry goal before driving through the door, to be sure the door has
fully opened.
This is the time from when the AMR arrives at the entry goal to when the door is
fully-opened, and it will vary depending on your door. You should time this, and
add a few seconds as a buffer, to ensure that the door is out of the way. The
default is 10 seconds.
f. Select the DoorSwingSector from the drop-down in the SwingSector field.
The MobilePlanner software will not let you finish creating a Door area if it does not
have two Door goals, an output, and a DoorSwingSector.
4. If multiple AMRs might try to use a door at the same time, create a single-robot sector
surrounding the Door area, DoorSwingSector, and both Door goals for the door.
Hints and Tips for Door Areas, Door Goals

Because the Door goals and DoorSwingSector have to be in place before you can create a Door
area, it may be visually easier for you to create a MovementParameters area where you want
the Door area to be. This can help in seeing where you should place the Door goals and the
DoorSwingSector. After these are created, you can edit the MovementParameters area, and
simply change it to a Door area. You would then enter the appropriate parameters, which
include the two Door goals and the DoorSwingSector, before saving the edit.
Another idea, if you are not familiar with dealing with your map yet, is to drive the AMR to
the location where you want the Door goal, and click the Goal at Robot icon to place a goal
there. You can then edit that goal, to change its type to Door goal.
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5.6 Operation

Configuring External I/O
NOTE: The Show Expert + Parameters box must be checked to see or modify I/O
parameters.
For external outputs, refer to Configuring an Output Signal on page 73 for an example of configuring Output1. Repeat the steps for Output2, if you will use it.
For external inputs:
1. Go to MobilePlanner > Config > Robot Interface, then
2. External Digital Inputs > Device<xx:yy:zz>_Input_1
l

Alias
Meaningful name to use in place of the raw name (Device<xx:yy:zz>_Input_1).

l

Inverted
True (enabled) if logical ON is electrically low, or ground, for this device. False if
logical ON is electrically high.

l

OnList
List of responses when Device<xx:yy:zz>_Input_1 switches on. These are selected
from a drop-down, and determine what happens when the input switches ON.
o

Suffix
Suffix appended to the alias when the input switches on. If an alias is not
specified, then the suffix is appended to the raw name.

o

Count
Number of responses when Device<xx:yy:zz>_Input_1 switches on.

o

Type1
A response when the Input_1 switches on. This field will not be displayed
if Count is zero.

l

OffList
List of responses when Device<xx:yy:zz>_Input_1 switches off.
The parameters for Offlist are the same as for Onlist, with "off" replacing "on".

Repeat these steps for Input_2, if you will be using it.

5.6 Operation
Call/Door Box Power-on
All LEDs will come on when the unit is powered up.
After about one minute, when the box has finished powering-up, the distance and red LEDs
will go off. The blue push-button LED will stay on.

76

LD Platform Peripherals Guide

13732-000 Rev H

Chapter 5: Call/Door Boxes

Call Buttons

A

B

C
K
D

L

L

L

L

E
H
J

F

J

Figure 5-26 Sample Component Connections, for a Fleet Installation
Key

Meaning

Key

Meaning

A

Server Room

F

WMS/MES

B

Factory Floor

H

802.11 Access Point Controller

C

EM

J

AMR

D

Ethernet Network Switch

K

Ethernet Call Button

E

ARCL

L

WiFi Call Button

AMR Request, Sequence of Events

NOTE: Call buttons have two optional outputs that can be used for an external
beeper, light, or other device. By default, these are both OFF. Changes in their
states are noted in this sequence. Call buttons are fully-functional without using
these outputs.
Regardless of the method of communication being used between the call buttons and the AMR
or EM, the sequence of events is essentially the same:
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1. Request
When an Operator presses a call button, the button sends a message requesting an
AMR for that call button goal.
2. In Progress
When the job status is In Progress, the call/door box host software sends a message to
the call button, so the button starts blinking slowly. This notifies the Operator that the
request was received, and is being processed. Output1 will turn ON.
If an AMR is sent to the goal by some means other than the call button, Output1 will
still turn ON, although the button won’t blink.
A ring of LEDs around the push-button will light, and count down the distance remaining for the AMR to reach the goal. When it gets within a certain distance, the corresponding LED will go out. See the following figure.

Figure 5-27 Call/Door Button Lights
NOTE: The HERE LED will be solid when the AMR is within 5 M, and
blink when the AMR has arrived.
NOTE: The LEDs will display the distance from the goal of the closest
AMR that is headed to that goal, regardless of the source of the AMR‘s
request. This includes requests made from the touchscreen on an AMR. If
the request did not originate from the call button, the button will not blink.
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3. Arrival
When the call/door box host software detects that the job's status changes to Arrived, it
sends a message to the call button, so the button starts beeping, and blinks rapidly. This
notifies the Operator that the AMR has arrived and needs attention. Output2 will turn
ON for at least one second. Output1 will still be ON.
The call button goal can have a delay associated with it, to give the Operator time to
unload or load the AMR, and to specify new goals, for AMRs that allow Operator input.
Goal tasks are set in the MobilePlanner software, which is covered in the Fleet Operations Workspace Core User's Guide.
The call/door box host software then dismisses the AMR, making it available for its
next job. This resets the call button to idle (and stops beeping and blinking). Output1
and Output2 will go OFF.
The two Outputs behave the same for an AMR sent to the call button‘s goal, regardless
of the source of that request (call button or touchscreen).
4. Cancel
If the Operator presses the button before the AMR has arrived, it sends a request to cancel the job. This can be at any stage of the request sequence before arrival.
When the queuing manager receives the request to cancel, via the call/door box host software, it cancels the job, and instructs the host software to send a signal back to the call
button. All of the LEDs, including the push-button LED, will blink briefly, and the
beeper will beep briefly. The call button will then return to its idle state, ready for the
next use.
If an AMR has been sent to the call button from the touchscreen, pressing the call button‘s button will not cancel that AMR’s existing job. Rather, it will enter a request for
another AMR to be sent to the call button‘s goal.
NOTE: The call button will report the distance of the closest AMR that is heading for the call button‘s goal.
Call Button Interface

NOTE: These behaviors do not apply to an AMR that has been sent using the
touchscreen.
Push-button
l

Pressing when call button is in idle state sends a request for an AMR

l

Pressing after an AMR has been requested sends a request to cancel the job

Push-button LED
l

On steady, all others off
Idle (Ready) state

l

Blinking slowly, some distance LEDs on
In Progress state

l

Blinking rapidly, beeper beeping
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Arrival state
l

Blinks briefly, then stays on
o

All distance LEDs blink briefly, then go out

o

Beeper beeps briefly

Request Canceled
Distance LEDs
l

All on
Request for AMR has been received by queuing manager

l

HERE and some adjacent distance LEDs on
In Progress, highest distance LED lit indicates approximate distance from AMR to goal

l

All blink briefly
o

Beeper beeps briefly

o

Push-button LED stays on

Request Canceled
l

HERE, 10m, 40m, and 150m on
Button has not been assigned a goal in the MobilePlanner software

Beeper
The beeper can be configured in the MobilePlanner software. It may turned off entirely, set to
beep for a specified number of seconds, or set to beep continuously, until the AMR is dismissed.
l

Beeps briefly when request is canceled

Red Error LED
l

OFF - good connection

l

Blinking - host connection lost

Door Boxes
NOTE: Except during power-up, most distance LEDs and the push-button
LED are not used for a door box. The HERE and 40m LEDs will be lit.
1. When an AMR reaches the entry goal for a closed door, it signals the queuing manager.
2. The queuing manager sends an open-door request, via the call/door box host software,
to the door box.
3. The door box signals the door actuator to open by turning its door output on.
Output1 must have been configured as a door output for this to happen. See Configuring an Output Signal on page 73.
4. The door actuator opens the door.
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5. After waiting WaitTime seconds (a parameter in the Door area) at the Door goal, the
AMR drives through the door.
6. When the AMR has passed through the Door area and the DoorSwingSector, it signals
the queuing manager.
This indicates that it is safe to close the door.
7. The queuing manager sends a close-door request, via the host software, to the door box.
8. The door box signals the door actuator to close by turning the door output off.
9. The door actuator closes the door.
10. The host software sets the door box back to a wait/ready state.

5.7 Specifications
Call/Door Box Specifications
Each call/door box is powered by 12 VDC.
Power consumption on average is 0.5 A, or 6 W.

Dimensions
123 (4.84)

50
(1.97)

15
(0.59)

74.69
(2.94)

30
(1.18)
141.37 (5.57)
Ø 2.4/7.5 A
(Ø 0.09/0.3) x4

76 (2.99)

B

40
(1.58)

Figure 5-28 Call/Door Box Dimensions, (A) Deep, and (B) Base Only (units are mm (inches))
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18 (0.71)

30
(1.18)

A

6.15
(0.24)

4.75 (0.19)

4.64
(0.18)

120 (4.72)
4x 3.5 (0.14)
72.3
(2.85)

7.17
(0.28)
139.96 (5.51)

Figure 5-29 Call/Door Box Wall Mount, (A) Possible Cable Exits (units are mm (inches))

Communication
The call/door box has options for the following communication methods:
l

l

Wireless Ethernet (802.11)
o

802.11a/b/g/n

o

2.4 GHz

o

5 GHz

Wired Ethernet

I/O Specifications
Inputs
l

100 mA circuit protection

l

User-supplied voltage-free contacts

l

Inputs and outputs are configured in the MobilePlanner software.
See Configuring External I/O on page 76.
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B

8

&

6

R

V5

0.10A

5

R

DIN_1-

7

VCC

R

DIN_2-

C
D

GND

A
Figure 5-30 Input Circuit Schematic
Key
Meaning
Key Meaning
A Digital Input Circuit C DOOR_IN1
B SAFE_5V
D DOOR_IN2
Outputs
l

NO relay with voltage-free contacts

l

Contact rating 30 VDC, 2 A max (resistive)

l

Supports 2 inputs and 2 outputs
These have preset behavior for call buttons, which cannot be changed. The outputs can
be used for a beeper, light, or other use. Both inputs act as external push-button presses.
NOTE: A call button can be turned into a door box with the DIP switch,
in which case the I/O can be configured by the user.
When used as a door box, Output1 is dedicated as a signal to the door actuator to open
the door. Only Output2 is available to the user.
Output1

l

Output2

Input1 Input2

Call Button ON when
ON for ≥ 1 second Button
In Progress after Arrival
press

Button
Press

Door Box

Door

user

user

user

I/O Box

user

user

user

user

Inputs and outputs are configured in the MobilePlanner software.
See Configuring External I/O on page 76 and Configuring an Output Signal on page 73.
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DOUT_1-

DOUT_1+
DOUT_2-

DOUT_2+

1
2
3
4

A
Figure 5-31 Output Circuit Schematic, (A) Digital OUT Relays

User Interface
The call/door boxes are physically the same, whether they are being used as call buttons or as
door boxes.
Call/Door Boxes light all LEDs on power-up. Initialization takes about a minute. Then the
LEDs, except for the blue push-button LED, will go off.
Call Buttons
l

l

One push-button with LED to call or cancel an AMR and indicate the call button status
Eight LEDs in a circle around the push-button to indicate the AMR distance from its
goal
HERE, 5m, 10m, 20m, 40m, 80m, 150m, 300m

l

Beeper to indicate that the AMR has arrived at the goal or request is canceled
This can be configured or turned off in the MobilePlanner software.

l

Red error indicator LED indicating loss of connectivity with the host

l

QR code containing link to Adept web site and call button documentation

Door Boxes

84

l

HERE and 40m distance LEDs around the push-button to indicate door box

l

Red error indicator LED to show connectivity with the host

l

QR code containing link to Adept web site and call button documentation
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5.8 WiFi Compliance
General WiFi
(According to ISO/IEC Guide 17050-1, 17050-2 and EN 45014)
Manufacturer's Name & Address:
Lantronix, Inc.
167 Technology Drive, Irvine, CA 92618 USA
Product Name Model:
PremierWave EN Embedded Device Server
Conforms to the following standards or other normative documents:
l

FCC Part 15.247/15.407 Class B

l

RSS-210

l

RSS-Gen Issue 2

l

ICES-003 Issue 4

Manufacturer's Contact:
Lantronix, Inc.
167 Technology Drive, Irvine, CA 92618 USA
Tel: 949-453-3990
Fax: 949-450-7249

FCC and IC - WiFi
P/N 13029-802 (WiFi, Lantronix):

Contains PremierWave EN Embedded Device Server
Conforms to FCC Part 15.247/15.407 Class B
This device complies with Part 15 of the FCC Rules. Operation is subject to the following two
conditions: (1) This device may not cause harmful interferences, and (2) this device must
accept any interference received, including interference that may cause undesired operation.

5.9 Supported Configurations
WiFi and wired Ethernet can be used concurrently.
In the following context, CDB is the call/door box and EM is the Enterprise Manager.

Single AMR
l

WiFi CDB -> WiFi infrastructure -> AMR

l

Wired CDB -> WiFi infrastructure -> AMR
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Fleet
Call Button
l

WiFi CDB -> WiFi infrastructure -> EM -> WiFi infrastructure -> AMR

l

Wired CDB -> EM -> WiFi infrastructure -> AMR

Door Box
l

WiFi CDB -> WiFi infrastructure -> EM

l

Wired CDB -> EM

Unsupported Configurations
Single AMR
l

WiFi CDB -> AMR
This has to go through the WiFi infrastructure before going to the AMR.

Fleet
l

WiFi CDB -> AMR ; EM -> WiFi infrastructure -> AMR
For a fleet, all communication must go through the EM.
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Acuity localization uses a camera to detect overhead lights, enabling the AMR to localize itself
in an environment where laser localization by itself is not an optimal solution.
Laser localization is largely tolerant of changing environments, but it becomes difficult where
more than 80% of the features seen by the laser change. This includes settings such as warehouses, where many objects like shipping pallets or rolling carts change locations often, or
which block the laser’s view of mapped features. Acuity is also useful when wide-open spaces
don’t provide enough features for laser localization.

When Acuity Won’t Work
l

l

Acuity localization will not work with indirect lighting.
In general, Acuity localization works if at least three light fixtures can be seen by the
camera. More is always better. If some of the light bulbs within a light fixture go out, it
should not affect Acuity, as long as there are some lights still on in the fixture.

Installation Scenarios
There are three basic scenarios that affect which sections of this chapter you will need:
l

l

l

Acuity localization has been ordered with a platform and a factory-designed payload
structure.
Acuity localization has been ordered with a platform, to be installed on a payload structure designed by you.
Acuity localization has been ordered as a kit, to be installed as an upgrade to an existing platform on a payload structure designed by you.

In the first case:
l

l

You will not have to install or configure any software, as that will have been done at
the factory. This includes the Acuity support software, the camera calibration file, and
the Acuity supporting libraries.
The location of the camera assembly will be predetermined, so payload structure design
is taken care of.

In the second case, the Acuity-related software will be installed at the factory.
In the third case, this entire chapter will be relevant.

Payload Structure Design
l

l

The location for the camera needs to provide a flat, level surface at least 57.2 mm (2.25
in.) in diameter.
The camera lens must be not be obstructed by any other part of the AMR. It has a 140°
field-of-view, so take care that nothing higher than the camera lens is close beside the
camera.
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l

l

The mounting location needs to provide a sturdy support for the camera, as any vibration or other movement of the camera makes localization difficult.
The payload structure needs four 4.6 mm (0.18 in.) holes and one hole, at least 17 mm
(0.68 in.) in diameter, in the center of that hole pattern. See Hole Pattern of the Camera
Enclosure Base (units are mm (inches)) on page 90.
Two of the 4.5 mm holes and the 17 mm hole must line up with the AMR‘s direction of
travel.
NOTE: For localization, the holes (and camera) need to be aligned within
one degree of rotation about the X and Y axes of the platform. See the following figure for hole orientation.

A

Figure 6-1 (A) Direction of Travel, Hole Pattern

6.1 Tasks
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l

Install camera assembly

l

Connect power and data cables between camera and platform core

l

Install Acuity software on AMR

l

Enable Acuity in MobilePlanner software

l

Load camera calibration file

l

Measure camera position and tilt, enter into MobilePlanner software

l

Create map (will contain both laser and Acuity data)
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6.2 Components
l

l

Camera Assembly
Camera

o

Three M3 x 4 screws

o

Bracket

o

Base

o

Four M4 x 12 screws

o

Tube

o

Neutral Density
(ND) filter, 55 mm

o

Foam dust seal

B

C

E

Cables
o

Ethernet cable

o

Power cable (Hirose
to 2x3 Mini-Fit Jr.™)

o

Power splitter cable

l

Software

l

Digital Level

l

A

o

D

F

Fast Ethernet switch
(optional, user-supplied)
Only needed if the
Auxiliary Ethernet port on
the platform is being used by
another peripheral.
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Figure 6-2 Acuity Camera Components
Callout

Description

Callout

Description

A

Neutral-Density Filter

F

Bracket

B

Foam Dust Seal

G

Direction of Travel label

C

Tube

H

M4 x 12 screws go up through
base

D

Camera

J

Base

E

Camera mounting screws
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6.3 Installation

6.3 Installation
NOTE: In this section, the figures show the camera assembly being mounted to
a test bracket. This is only used to show where the screws will attach. A typical
installation will have the mounting holes in the top of the AMR’s payload structure.

Camera Assembly
1. Attach the camera enclosure base firmly to the payload structure using one of the four
supplied M4 x 12 screws. The screw has to be inserted from inside your payload structure, through the payload structure surface, and into the single clinched nut in the camera enclosure base.
NOTE: It will simplify configuration, by minimizing the Theta offset, if
you mount the camera base so that the hole with the clinched nut is
facing toward the left of the AMR (+Y).
l

l

Mount the base to the mounting location using an M4 x 12 mm socket head
screw. You may need to use a longer screw depending on the thickness of your
mounting location. A washer and lock washer are recommended, though not
shown here.
Note the orientation of the base with regards to the direction of travel. Make sure
the other three holes are aligned before tightening the screw.
A

H

B
G

B
M4 x 12 F
Ø 57.2 (2.25)
Ø 31.0 (1.22)

4x Ø 4.6 (0.18) C

Ø 17.3 (0.68) C

D
E

Figure 6-3 Hole Pattern of the Camera Enclosure Base (units are mm (inches))
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Callout

Description

Callout

Description

A

Camera Enclosure Base

E

Note: Test Bracket is for Illustration Only.

B

Direction of Travel

F

Screw

C

Through Hole

G

Note: Test Bracket is Shown for
Illustration Only. To Mount to
Your Own Location, See Detail
of Base Mounting Holes.

D

Detail of Base Mounting Holes

H

Mounting Location

2. Mount the camera bracket to the camera enclosure base.
The bracket will only fit on the base one way.
Attach the camera bracket firmly to the base using 3 M4 x12 mm socket head screws.
You may need to use longer screws depending on the thickness of your mounting location. Washers and lock washers are recommended, though not shown here.

A

C

B

3x M4 x 12 D

Figure 6-4 Mounting the Camera Bracket (units are mm)
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Callout

Description

Callout

Description

A

Camera Mounting Bracket

C

Camera Enclosure Base

B

Note: Test Bracket is Shown for
Illustration Only. To Mount to
Your Own Location, See Detail
of Base Mounting Holes.

D

Screw

The screws have to be inserted from inside your payload structure, through the payload
structure surface and camera enclosure base, and into the three clinched nuts in the bottom of the camera bracket.
There is a sticker on the camera bracket that shows the direction of travel of the AMR.
See the following figure. Verify that the arrow on the sticker is pointing toward the front
of the AMR.

Direction of Travel
Omron Adept Technologies, Inc.
4550 Norris Canyon Road
San Ramon, CA 94583

Model:
P/N:

Acuity
13700-000

Figure 6-5 Label on Camera Mounting Bracket
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103.6
(4.08)

103.6
(4.08)

91.7
(3.61)

2x 91.7
(3.61)

33 (1.30)
26.7 (1.05)
9.9 0 9.9
(0.39) (0.39)
5.1 (0.20)
23.6 (0.93)

72.1
(2.84)

5.1 (0.20)
6x R1.5
(0.06) B

C

R5.1 (0.20)

R5.1 (0.20)

5.8 (0.23)
0
0

8.4
(0.33)
0
3x Ø 5.3 (0.21) A
90° on Ø 31 (1.220) CL

16
30.5
(0.63) (1.20)
Ø 42.9
(1.69)

16 (0.63)
5.1 (0.20)

Ø 17 (0.67)

B

10 (0.394)

Figure 6-6 Dimensional Drawing of Camera Bracket, (A) Through Holes Equally Spaced at,
(B) Through Hole, and (C) Label on Back (units are mm (inches))
3. Attach the camera to the camera bracket.
a. Attach the camera cables to the camera before mounting the camera.
Refer to Camera Connections on page 94.
b. Attach the camera to the mounting bracket using three M3 x 4 mm button head
screws.
NOTE: The camera needs to be mounted as high in the bracket as
possible, without its lens adapter interfering with the ND filter.
This prevents the tube itself from limiting the camera’s angle of
view.
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3x M3 x 4 A

B

C

Figure 6-7 Attaching Camera to Camera Bracket, (A) Button Head Cap Screws, (B) Camera
Mounting Bracket, and (C) Camera (units are mm)
Camera Connections

The camera requires a power cable and an Ethernet cable connected to the platform
core. These will pass through the center (17 mm) hole in the camera enclosure base and
bracket.
IMPORTANT: The Acuity camera's signal cabling is sensitive to interference from noise and its power supply is sensitive to ripple. Route signal cables to avoid interference. If your payload's power demand is high,
or you need to add other devices to the AUX power circuit, carefully test
Acuity operation before deploying and contact your local Omron Support
if you have problems.
a. Feed the Hirose end of the power cable and one end of the Ethernet cable up
through the 17 mm hole in the center of the base and bracket, from inside your
payload structure.
b. Connect the Hirose end of the power cable to the camera.
See the following figure.
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Figure 6-8 Hirose Plug
c. Connect the Ethernet cable to the camera.
d. Connect the 3x2 Mini-Fit Jr. power cable from the camera to the 3x2 Mini-Fit Jr.
power splitter cable (inside the payload structure).
e. Connect the Mini-Fit Jr. splitter to the core’s AUX POWER port.
The splitter will leave one available Mini-Fit Jr. power connector available for
other uses.
f. Connect the Ethernet cable from the camera to the Auxiliary Ethernet port on the
core.
NOTE: If other peripheral items, such as the touchscreen interface,
also require the use of the Auxiliary Ethernet connection, then a fast
Ethernet switch will be required (user-supplied).
4. Attach the tube onto the base.
The threads at the bottom of the tube are coarse, and match the threads on the base. The
threads at the top of the tube are fine, and match the filter.
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A

B

Figure 6-9 Attaching the Tube to the Base, (A) Tube, and (B) Camera Enclosure Base
5. Install the foam dust seal and ND filter.
a. Insert the foam seal around the camera lens and press into the tube until the seal
sits on the camera body.
b. Thread the neutral density filter onto the camera enclosure body (tube).
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A

B

C

D
Figure 6-10 (A) Filter, (B) Foam Seal, (C) Tube, and (D) Completed Assembly

Software Installation
This step only needs to be taken if you are adding Acuity localization as an upgrade to an
existing system.
Install the Acuity supporting libraries first. This package will either be supplied with the Acuity order, or it can be obtained through our applications engineering staff. Refer to SetNetGo Managing Software Packages on page 25.

6.4 Setup
Enabling Acuity
In MobilePlanner

In order to enable Acuity, you need to check the LightLocalization and
DisableLaserLocalization parameter boxes in MobilePlanner > Config
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Robot Operation > Localization Modules

Figure 6-11 Enabling Acuity in the MobilePlanner Software
These will only be visible if the Show Expert + Parameters box is checked.
For normal Acuity operation both boxes should be checked. This will cause the AMR to use
only the Acuity camera for localization.
NOTE: Currently, only one form of localization can be used at once.
After enabling Acuity, save the changes to the configuration. The AMR’s software will reboot.
NOTE: After making and saving Acuity changes within MobilePlanner, the
robot has to be power-cycled for those changes to take effect.
In SetNetGo

Select MobilePlanner > SetNetGo
Network > User LAN Ethernet
Make sure the radio button for Interface mode: is set for Accessory, and that DHCP Server for
Accessories is set to Enable. See the following figure.

Figure 6-12 Accessory Radio Button, DHCP Server for Accessories Enabled
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NOTE: The DHCP server must also be turned on, and a range specified. These
will be set at the factory if you buy an AMR with a touchscreen or Acuity localization.
From the Map

NOTE: This method of enabling or disabling modes of localization is for expert
use only. You should not use this method unless you fully understand it.
If LaserLocalization is not disabled explicitly through the use of the Disable LaserLocalization
parameter, then it must be disabled using a map task. After enabling Acuity localization by
checking the box for LightLocalization and saving the configuration, new configuration sections related to LightLocalization will become visible, as will a set of tasks to be used in the
AMR’s map. Among these new tasks will be:
l

DisableLaserLocalization

l

DisableLaserLocalizationCancel

l

DisableLightLocalization

l

DisableLightLocalizationCancel

These tasks can be used to selectively switch between Acuity and laser localization.
NOTE: These tasks cannot be used while the AMR is moving. Place the tasks in
a macro, in a virtual door, or after a goal where the AMR is expected to switch
localization modes.
Use the Custom Response, Startup to run the DisableLaserLocalization task when the AMR
boots. Later, if you want to switch localization methods, use the tasks listed to disable one type
and cancel the disabling of the other type.

Importing the Camera Calibration
Each AMR equipped with Acuity localization will be supplied with a calibration file, which
you will need to import before Acuity localization can be used.
This process is completed using the standard MobilePlanner import:
File > Import Config
The file name for the camera calibration file matches the camera serial number.
To import the camera calibration:
1. With LightLocalization enabled, use the Command tool in the MobilePlanner toolbar to
select PopupCameraSerialNumber.
2. If you do not see the Commands tool in MobilePlanner, right click in the blank space in
the toolbar area.
Check the selection for Custom Commands.
3. Click the Command drop-down arrow, and click PopupCameraSerialNumber.
You will see a popup with the camera serial number:
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Figure 6-13 Getting the Camera Serial Number
4. Load the camera calibration file, which was provided with the Acuity system, from
MobilePlanner by selecting File > Import Config, then navigating to the location of the
file on your PC.
The name of the calibration file will match the serial number of your camera, with a .txt
extension. Make sure that the checkbox for Acuity Camera Calibration is checked in the
dialog box, and click OK to load the calibration file. After importing the Acuity Camera
Calibration file, save the configuration again. See the following figure.

Figure 6-14 Importing the Acuity Camera Configuration File

Compensating for Camera Position and Tilt
Enter the position of your camera with respect to the AMR into the MobilePlanner software.
Refer to the following figure.
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+X

X=0
Y=0

500
(19.7)

X=0
Y=0

+theta

+Y
17.5
(0.69)

697 (27.4)
5.5 (0.22)

Z=0

+Z

A

Z=0

Figure 6-15 Measuring the Camera-Platform Offsets, (A) At Sensing Plane of Camera (units are mm
(inches))
1. Measure the X and Y distance from the center of the AMR (X = 0, Y = 0) to the center of
the camera (X = 0, Y = 0).
2. Measure the vertical distance from the floor to the plane of the camera’s sensor.
To measure this distance, measure from the floor to the top of the camera (not the top of
the lens) and subtract 17.5 mm.
Alternatively, measure from the floor to the top of the rectangular portion of the camera
and subtract 5.5 mm. Round all measurements to the nearest millimeter.
3. Enter the measured values in MobilePlanner > Config
Robot Physical > Acuity Camera Position
in the parameters CameraOffsetX, CameraOffsetY, and CameraOffsetZ.
If the camera is toward the front of the AMR it will have a positive X value. If it is
toward the rear of the AMR it will have a negative X value.
If the base is mounted per instructions, the camera will have its rear side, with threaded
holes for mounting it, facing +Y of the AMR (the AMR‘s left side). This will result in a
CameraOffsetTh (theta) of 0. If this is not the case, then a theta offset must be applied.
For example, if the back of the camera is facing the rear of the AMR, the CameraOffsetTh will be 90, as a counter-clockwise rotation is positive.
4. Finally, measure the tilt of the camera with respect to the floor using the dual-axis
digital level that was included with the Acuity package.
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NOTE: The Acuity localization kit can be ordered without the level. In
such cases, it is assumed that you already received one kit WITH the
level, and will use that for multiple Acuity localization setups.
a. Bring the AMR to a level, hard floor. Do not use carpeted floor.
b. Place the digital level on the floor with the edge pressed against the right wheel
cover, buttons toward the front of the AMR, and the display facing straight up.
See the following figure.
c. Zero the level. (Press ZERO.)
The bubble on the display should be centered, and the values for X and Y tilt
should be near zero.

A

B
Figure 6-16 Zeroing the Level, (A) Front of Robot, and (B) Correct Level Orientation
d. Place the level, facing up, over the camera and top of the bracket.
The USB port on the level (which is not used in this procedure) should be on the
same side of the level base as the slot for the camera bracket. The level and base
should have been delivered to you this way. See the following figure.
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A

B

Figure 6-17 Level Base, (A) USB Port, and (B) Camera Slot
It will only fit one way, with the slot in the plastic base of the level fitting over
the back side of the camera mounting bracket. The slot is called out in the preceding figure.
5. Enter the values directly from the display into MobilePlanner > Config
X AXIS = Robot Physical > Acuity Camera Position > CameraTiltX
Y AXIS = Robot Physical > Acuity Camera Position > CameraTiltY
Be sure to include the + or – sign. You can press the HOLD button on the level to lock
the values.

Figure 6-18 Transferring Level Readings to the MobilePlanner Software
6. Reinstall the foam dust seal on the camera, and screw the camera tube back onto its
base. Ensure that the camera’s light filter is in place in the top of the tube.
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6.5 Making a Map of Your Environment
In order to have your AMR perform autonomous mobile activities, you need to make a map of
its environment. Use the MobilePlanner software to make a map. Refer to the Mobile Robot
Software Suite User's Guide.
The tasks involved are:
l

Make a scan of the operating space while driving the AMR with the joystick.
NOTE: It is a good idea to have the automated docking station installed
before you make the scan. The distinctive angle and shape of the front of
the docking station will be useful in locating and setting it up in the map.

l

Load that scan from the AMR into MobilePlanner, on your PC, to create and edit the
map.

l

Transfer the working map back to the AMR or EM.

l

Localize the AMR with the newly-created map.
This is especially important for Acuity localization. Ensuring that the AMR is properly
localized, as opposed to offset by one or more lights, is critical.

Scanning the Environment
Light-Related Parameters
l

Parameters in the Light Analysis Section are used for mapping only.

l

Parameters in the Light Localization section apply only to runtime, not mapping.

l

Light Video Analysis parameters apply to the images used for both mapping and localization.
If the MinRefreshInterval—the rate at which new images are acquired—is higher than
the LightTimer in the Light Localization section, then light localization will be limited
to the MinRefreshInterval. The AMR can’t localize faster than it is receiving new
images from the camera.

The laser and light data are generated from the same scan. You only have to drive the AMR
through the environment once to gather the information necessary for a map containing points
and lines generated from the laser data, as well as rectangles, used to represent facility lighting, generated from the camera images.
Light Height

Before scanning, measure the height from the floor to the lights. Use the height of the lights,
not the ceiling, as most lights are set away from the ceiling by some amount. For diffused fluorescent lights, in an office setting, the ceiling height is typically fine. Metal-halide dome lights
in high-bay warehouses are typically hung from the ceiling by about one meter.
Enter the height of the lights in the AMR’s configuration in the Robot Operation > Light Analysis section. The 3d: MinLightHeight parameter should be about 15% less than the measured
height, and 3d:MaxLightHeight should be 15% more than the measured height. All lights
between those heights will be included when the map is created.
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Enter the actual measured height into the 3d:DrawingLightHeight parameter (this is strictly for
display purposes, and does not affect AMR operation).
If there are areas within the environment that have different light heights, you do not have to
scan the space again. Pick one light height to be first, and enter the values for Min and Max
light height into the configuration before scanning. You can adjust these later, and multiple
maps can be processed from the same scan file. This will be covered later.
Light Size

Measure the size of the lights. By default the maximum light length is set at 2000 mm to prevent the detection of large, erroneous lights on a map. If your lights are longer than this, you
will need to increase the 3d:MaxLightLength parameter, which is in the Robot Operation >
Light Analysis section. The AMR will not be able to scan lights which are long and continuous, such that the light cannot be captured in a single image. For particularly large lights,
it may be necessary to change the 3d:DrawingMaxSize parameter, visible when the Show
Expert + Parameters box is checked, which limits the perimeter of a light. The default for this is
10000 mm.
Scan Pattern

Scanning for Acuity localization is carried out the same way as for the laser alone, starting
and stopping the scan from the MobilePlanner software. When scanning for Acuity, make sure
you drive the AMR underneath each light that is visible from any point you want the AMR to
go. This generally requires more driving than for a laser-only scan.
For a space that is about 30 x 30 meters, the following path was used for the scan. Lights are
represented as light blue rectangles on the map created from this scan.

Figure 6-19 Sample Mapping Strategy
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Figure 6-20 Resultant Map

Creating a Map
After finishing the scan, proceed with creating a map:
1. Open the scan file on the AMR using MobilePlanner > File > Open on Robot.
l

l

Select the IP address of your AMR.
Both a .2d and a .z2d version of the scan file you just created will exist on the
AMR.
Choose the .z2d version of the scan file, which contains both the light data and
laser data.

The laser scan will be processed first, followed by the extra processing for the lights. If
all of the parameters were set properly, the light blue light items will be visible on the
map overlaid on the points and lines from the laser data.
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Figure 6-21 Initial Map, with both Laser and Light Data
2. If you are satisfied with the map:
NOTE: Check that the lights are where you think they should be, and
their general dimensions are accurate.
a. Save it to your PC.
NOTE: If you have lights at multiple heights, do not click Finish
on the Scan Processing Tools toolbar.
b. Click Save on Robot, then select the IP address of either the AMR or the EM, if
your AMR is part of a fleet.
3. If you are not satisfied with how the lights appeared on the map, click Config on the
Scan Processing Tools toolbar to open the configuration dialog box. This gives you
access to the Light Analysis parameters, which you can change as needed:
l

3d:MinLightHeight

l

3d:MaxLightHeight

l

3d:MaxLightLength

l

3d:DrawingMaxSize

In the preceding image, the light length was 2.5 meters, so the default light length of 2
meters was too restrictive and needed to be changed.
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Lights at Multiple Heights

The scan contains the necessary data for all of the lights in the environment. When you create
a map from the scan, you specify a height range for the lights you want included in that map.
If your environment has lights at multiple heights, you will need to create multiple maps from
your one scan, using different light heights. You will then insert the appropriate map sections
into the initial map, which will add the lights from the adjusted light height range. This needs
to be done for as many different light heights as you have in the environment.
Creating a Revised Map

These steps are performed after saving the initial map, which included lights within the initial
height range you specified.
NOTE: Do not click Finish on the Scan Processing Tools toolbar.
1. Click Config and change the 3d:MinLightHeight and 3d:MaxLightHeight parameters to
bound the next light height in your environment.
2. Click Apply, and say Yes to the pop-up.
Applying the changes will cause only the light map to reprocess.
3. If you are satisfied with the appearance of the lights in this height range, save the new
map with a different file name.
NOTE: Check that the lights are where you think they should be, and
their general dimensions are accurate.
4. Repeat these steps for as many different light heights as are needed.
Inserting a Map

1. Open the initial map file.
2. Select File > Insert Map.
3. Select the map file you want to insert.
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Figure 6-22 Selecting a Map File to Insert

Figure 6-23 Inserted Map
4. Click and drag the purple highlighted map to line it up with the initial map.
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a. Try to get the features of the two maps close, dragging the purple insert.
b. Zoom in very close. You should be able to align the two laser maps perfectly, as
they are identical maps with only differences in the lights.

Figure 6-24 Zoomed-in Insert Map
c. Click Insert to complete the insertion.
5. Zoom back out and use the Region Tool, from the Insert Map Tools toolbar, to click and
drag a rectangular region that includes the lights you want inserted.
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Figure 6-25 Region Tool
6. Click the dropdown arrow next to the Insert button on the Insert Map Tools toolbar and
click Advanced.
This will open the Advanced Insert dialog box.
7. Click Clear All, then select just the Light check box in the Advanced Areas section.
8. In Advanced Options, check the boxes:
l

Include user-created map items, i.e. non-data types

l

Retain overlapping items of the same type in the containing map
NOTE: If lights of different types are physically behind one another in the
environment it may be necessary to scan that space twice, once with just
each light type exclusively. This means that you would have to turn off
lights at one height, then scan, and repeat with only the other lights
turned on.
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Figure 6-26 Advanced Insert
9. Click Insert on the Advanced Insert Dialog box and save your changes.
10. Repeat the steps in this section for all other map areas with different light heights.
11. If you are satisfied with the map:
a. Save it to your PC.
NOTE: If you have lights at multiple heights, do not click Finish
on the Scan Processing Tools toolbar.
b. Click Save on Robot, then select the IP address of either the AMR or the EM, if
your AMR is part of a fleet.
NOTE: After mapping DO NOT manually move, resize, reorient, or otherwise
modify the light items on the map. If lights did not turn out as expected, some
combination of parameter changes should allow reprocessing of the scan in
order to achieve better results.

6.6 Operation
Localizing Manually
It is very important to localize the AMR well by hand when starting it on a new map for the
first time, or re-localizing if it became lost. It is possible to offset the AMR up/down or left/right
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by a row of lights. This will cause the AMR to think it is one row of lights from where it really
is, so it will not be able to drive to goals, and might drive into forbidden zones.
NOTE: Even with laser localization disabled, the laser stays active for obstacle
avoidance, so the AMR will not run into physical objects.
After the initial localization, the AMR will continuously verify and adjust its position on the
map as it moves through the environment.

Interpreting Light Objects on the Map
Lights are represented by light blue rectangles. If lights do not appear on the map, enable their
display by using the Map > Map Data > Light Items menu item in MobilePlanner.
From Map > Robot Data > Other Robot Data,
l

l

l

LightMatch compares the lights that an AMR has detected with its camera to the lights
on the map. Light matches are displayed in green.
LightMisses shows lights that are seen by the camera and meet the criteria for a proper
light, but which do not match a known light on the map. Light misses are displayed in
magenta.
Lights3d displays all lights in red, regardless of their match or miss status. Generally
this is left off to prevent cluttering the display.

6.7 Camera Specifications
Feature

Specification

Field of View

140°

Power Input

12 VDC (±10%) supplied from platform,
through power connector

Power Consumption 3.3 W maximum
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Chapter 7: Side Lasers
NOTE: There are two types of side laser installations. One is attaching them directly to the user-designed payload, which is what this chapter covers. If you
have a Cart Transporter, the side lasers are covered in that manual.
Side lasers can be added to an AMR to provide additional obstacle detection. The OS32C
safety scanning laser scans at 190 mm (7.48 in.) from the floor. Any obstacle that does not
cross that plane will not be seen. Side Lasers scan in a vertical plane near the path of the
robot, allowing the AMR to detect obstacles at other heights that the AMR must avoid. These
are standard on most factory-built AMRs, and are available as an option for users building
their own payload structures.

Positive Obstacles
Positive obstacles are those which would block the robot’s path, such as tables and desks.
Detecting positive obstacles is the primary and recommended use for side lasers.
Negative Obstacles
Negative obstacles are voids in the driving area of the robot, such as downward stairs, loading
docks, or missing floor tiles.
Negative obstacle detection with side lasers should not be used as the primary method for
avoiding negative obstacles. It is intended to be used as a secondary method of detection, with
the primary method being traditional safety techniques to aid avoiding negative obstacles.
Primary methods include blocking off areas with missing floor tiles, staging safety equipment
near areas missing floor tiles, and restricting traffic to dangerous areas.
Negative obstacle detection on the robot is implemented in software only and does not consist
of CAT 3/PLd safety lasers. A test plan should be developed and executed prior to adding new
functionality to equipment that currently exists in a production environment. Perform testing
with each specific application and configuration to ensure the robot’s safety. Test detection
after changing parameters for each different expected obstacle. With customer payloads and
laser positioning, dynamic testing must be done for each design at field application speed to
ensure robot safety.

7.1 Installation
Components
The side lasers come as a kit with the following components:
l

2x lasers

l

2x laser guards

l

Wiring harness

l

Assembly kit, with mounting plate

The side laser kit is P/N 13456-100, and can be added to existing payload structures.

13732-000 Rev H

LD Platform Peripherals Guide

115

7.2 Configuration

Mounting
Side lasers need to be mounted on your AMR payload structure, one on each side. They must
be mounted far enough out so that their laser beams don’t hit any part of the AMR.
Connections
The harness should be connected after the physical mounting procedure is completed.
The lasers connect to the Aux Sensor connector located on the upper front of the platform core
using the supplied W-cable. This allows you to use one port for both side lasers and the low
front laser.

7.2 Configuration
The parameters for the side lasers are set using the MobilePlanner software.
The first set of parameters are in:
Robot Physical > Laser_3 and Robot Physical > Laser_4.
Configuring the side lasers is generally performed by importing the factory-supplied configuration into the AMR’s current configuration. Contact Omron Adept Technologies, Inc. for
assistance.
For Laser_3 (right) and Laser_4 (left), the relevant parameters are:
l

LaserAutoConnect: Should be checked to turn on the laser.
This parameter will not be shown unless Show Expert + Parameters is checked.
This tells the system that the laser exists, and should be connected at startup.
The other parameters will be hidden unless this parameter is checked.

l

LaserX, LaserY, LaserZ: The location of the laser on the robot.
Measure to the sensing plane of each laser, which is about 20 mm from the top of the
sensor housing.

l

o

LaserX is mm, front-back, of the laser center from the robot’s idealized center of
rotation.

o

LaserY is mm, left-right, of the laser center from the robot’s idealized center of
rotation.

o

LaserZ is mm, from the floor to the center of the laser.

LaserIgnore: By default, the sensor scans an area of 270 degrees.
This area should be modified so that the laser does not sense parts of the AMR. Zones
entered here will be excluded from the search area.
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A

Figure 7-1 Left Side Laser (Laser 4), (A) This Laser is Flipped Upside-Down
The format for the angles is startangle1: stopangle1, startangle2: stopangle2, etc.
Readings inside these angles will be ignored.
An example would be
-20:-180,45:180
l

LaserFlipped: For the laser on the left side of the robot, check the box.
This says the laser is upside-down, so the readings are interpreted correctly.

l

LaserType: Set this value to tim3XX unless otherwise requested.

l

LaserPortType: Set to serial when using the Aux Sensor connector.

l

l

l

LaserPort: The ports available on the Aux Sensor connector are /dev/ttyUSB5 and
/dev/ttyUSB6. Assure that the correct port is designated by the sensor’s X,Y,Z position.
The wiring harness is labeled so that /dev/ttyUSB6 is connected to the left laser.
LaserPowerOutput: Set to Vertical_Laser_Power.
LaserIsTilted: Designates that the lasers are side-mounted and will scan vertically.
Check the box.
The parameter LaserIsTiltedNegativeSensor should be disabled if this is checked.
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7.2 Configuration

Figure 7-2 MobilePlanner Side Laser Parameters
In MobilePlanner, navigate to Robot Operation > Laser_3 and _4 Tilted. This portion of the configuration allows the laser to be configured for the application’s specific environment.
In select cases, you will need to modify the Cumulative parameters. Sensor readings are often
held on the map so that the robot remembers an obstacle even when it cannot be actively seen.
The length of time that the robot will remember these readings is
MaxSecondstoKeepCumlative. In dynamic environments where the robot will be encountering
many obstacles, but many open paths for the robot exist, this value should be about five
seconds. If your environment has a restricted number of possible robot paths, this number
should stay relatively large, such as thirty seconds, so that the robot does not rediscover the
same obstacle multiple times. Contact your local Omron Support if you have difficulty tuning
these parameters for your environment.

Figure 7-3 MobilePlanner Cumulative Parameters
After each side laser is configured, ensure that the laser designated to be on the left side is
physically mounted on the left side of the robot. The easiest way to do this is to turn off one of
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the lasers using the LaserAutoConnect parameter and watch the laser readings in MobilePlanner. In the image below you can see that the enabled side laser is showing readings on the left
side of the robot.

Figure 7-4 Checking the Left Side Laser
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Chapter 8: LD-250 Rear Facing Laser
For the LD-250, You can configure an additional laser either as a rear-facing laser or as a vertical laser. In the latter case, mount the laser so that its scan plane is perpendicular to the floor
plane and parallel to the AMR's X axis.
IMPORTANT: LD-60, LD-90 or LD-xxxCT models do not support this option.
The rear-facing laser kit consists of the following items.

Figure 8-1 Rear-facing Laser Kit
Callout

Part Number

Description

A

14851-000L

Debug Port DB9 adapter cable.

B

14682-000L

TiM to DB9 adapter cable with Aux Power split.

C

3438-000

TiM-510 laser, firmware version 3.15

8.1 Laser Location and Orientation
To configure a laser into MobilePlanner, you must know its position and orientation in relation to the AMR's center of rotation, coordinate system, and direction of forward travel.
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8.1 Laser Location and Orientation

Figure 8-2 Supplemental Laser Orientation
Callout

Description

1

Pivot point mark, the origin of the laser's scanning field.

2

Front mark arrow, the center (0 degrees) of the laser's scanning field.

3

Scanning field arc, in this case 200 degrees.

Figure 8-3 Laser Sensing Plane
Callout

Description

1

Cap over the laser's lens.

2

Lens return zone, detects returned (bounced) laser light pulses. This is approx 10
mm wide.

3

Lens emitter zone, sends laser light pulses. This is about 8 mm wide and is the location of the scanning field plane.

The emitter zone is the point from which you measure the laser's physical location, relative to
the AMR's center of rotation.
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Measure in the horizontal plane, from the AMR's center of rotation to the sensor of each laser,
approximately 20 mm from the top. Determine the following measurements:
l

LaserX (front to back)

l

LaserY (left to right)

l

LaserZ (height from floor)

8.2 Ignoring Laser Zones
By default, the sensor scans an arc of 270 degrees. There might be are sections of this arc that
intersect with the AMR or its payload, or with laser protective covers. Therefore, you might
need to set these sections to be ignored by the software. This will make sure that the AMR or
its payload are not detected as obstacles, preventing vehicle motion.

Figure 8-4 Calculating Values for Ignored Laser Zones
Callout
A

Negative direction (Clockwise)

B

Positive direction (Counterclockwise)

C

Laser with a 270 degree scanning plane

D

Scanned segment of the 270 degree plane

E

Ignored segment of the 270 degree plane

When calculating these values:
l

Degrees of arc relate to the AMR's coordinate system, and not the laser's angular range.
You specify values in the ranges 0° to +180° and 0° to -180° .

l

0 (zero) degrees specifies the AIV's forward direction of travel.

l

The value for an ignored segment cannot span +180 and -180. Thus:
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l

o

To ignore the ten degree segment between +175 and -175, you must specify two
ranges: -175:-180, 180:175.

o

Specifying the range -175:175, causes the software to ignore a 350 degree segment, clockwise from 175 to -175.

Consider also the LaserTh, parameter which specifies the scanning field orientation,
and whether the laser is tilted when calculating the ignored segment.

8.3 Install the Rear-Facing Laser
Mechanical installation of the laser to your payload might require custom or brackets or
optional brackets from the laser manufacturer.
The laser connection uses the following ports on the LD-250 Core:
l

Debug port. This port is below the AMR's top deck.

l

AUX_20V port.

The following procedure assumes that you have put the AMR into a safe state for mechanical
and electrical work.
Install the lasers as follows:
1. Remove necessary components to access the LD-250 Core.
2. Connect the cable as follows:
a. Connect the DB9 plug to the LD-250 Core's Debug port.
b. Connect the Molex plug to the LD-250 Core's AUX_20V port.
3. Mount the laser facing in the appropriate direction (typically the opposite direction of
the main safety laser.)
4. Route the cable to the laser, using cable ties to keep it clear of moving parts. Allow
enough slack for removing the payload.
5. Connect the cable's multipin connector to the laser.

8.4 Configure the Rear-Facing Laser
To configure Side Lasers:
1. Open MobilePlanner and connect to the AMR.
2. Open the Robot Physical tab and check the Show Expert Parameters option.
3. Under the section titled Laser_5, the following default parameters are configured:
a. LaserTH -180.00000.
b. Enable the LaserAutoConnect option.
c. Select LaserType tim3XX.
d. Select LaserPortType serial
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e. Select LaserPort /dev/ttyUSB11
f. Select LaserPowerOutput Aux_20V
4. Save the configuration and wait for the AMR to reboot.
5. Open the workspace map and verify the laser readings.
6. Enter the laser coordinates as measured for the corresponding laser.

8.5 Set the Orientation and Position Values for the Laser
To set the coordinate values for the laser:
1. Connect MobilePlanner to the AMR and open the Robot Configuration.
2. Navigate to: Robot Physical and select Laser_X, where X is the identification number for
this laser.
3. Check the Show Expert + Parameters option at the top right of the window to display
the parameters that you must configure.
4. Check the LaserAutoConnect parameter to enable the laser at system start up.
5. Enter the laser's mounting location coordinates:
a. LaserX (front to back)
b. LaserY (left to right)
c. LaserZ (height from floor)
6. If required, use the LaserIgnore parameter to specify ignored segments of the scan field.
7. If required, set the LaserFlipped parameter to true if the laser is inverted, or is on the left
side of the AMR.
8. If required, set the value of LaserTH depending on the direction of the laser's scan field
in relation to the AMR's direction of travel. (Such as -180 for laser pointing away from
the direction of travel).
Verify in MobilePlanner that the rear-facing laser is detecting obstacles in the correct locations
The laser location configuration must be accurate to the laser's physical mounting location on
the AMR.
To verify the installation make sure that the AMR can:
l

Stop before it collides with obstacles detected by the rear-facing laser.

l

Dock and charge.
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Chapter 9: High Accuracy Positioning System
9.1 Overview
The High Accuracy Positioning System (HAPS) option allows an AMR to achieve accurate
alignment at a specific location, such as at a fixed conveyor. It is available as an option for all
Omron Robotics and Safety Technologies, Inc. AMRs.
The HAPS option uses a sensor to follow a strip of magnetic tape that has been applied to the
floor at a location where high accuracy is needed. Two sensors allow the AMR to follow the
tape both forward and backward. With one sensor, the AMR can only follow the tape when
driving forward.
Apply tape to the floor leading up to the tool or conveyor that you want the AMR to approach
closely. Markers (short sections of the tape) are used to signal the AMR where to stop.
The simplest installation consists of a goal on the AMR‘s map, a length of magnetic tape, and
one marker. The goal will have tasks that direct the AMR to proceed to the tape, follow the
tape, and stop at the marker.
For locations with multiple places where you want the AMR to stop, you would use a continuous tape strip for all stops, with one marker at each stop, one goal for each marker, and an
Engage task for each goal. The goals would all be at the same location, near the start of the
tape. The Engage tasks allow an AMR to follow the tape, performing tasks from the successive
goals, without ever having to return to the location of the goals.

9.2 Components
The factory-supplied component is the HAPS sensor. One sensor allows accurate positioning
driving forward. For installations that need the AMR to drive both forward and backward
along the tape, two sensors are required.
In either case, the system requires magnetic tape applied to the floor at the specific locations. (It
is generally the customer's responsibility to install the magnetic tape.)
The HAPS option requires ARAM 4.7.6 or later software.

9.3 Sensor Installation on the LD-60, LD-90, and LD-xxxCT
Factory Installed
If the HAPS option is ordered with an AMR, the sensor(s) will be installed at the factory, and
the software will be configured at the factory, to make use of the HAPS option.

Field Upgrade
These Field Upgrade instructions only apply if you are installing the HAPS option on an existing AMR.

Mounting Locations for the LD-60, LD-90, and LD-xxxCT
Figure 9-1 shows the mounting locations for the LD-60, LD-90, and LD-xxxCT.
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9.3 Sensor Installation on the LD-60, LD-90, and LD-xxxCT

239.8
(9.44)

A
CL

B

139.5
(5.49)

E

F

C
D

Figure 9-1 Mounting Positions for Brackets and Sensors (units are mm (inches))
Key

Meaning

Key

Meaning

A

Axle

D

Mounting Hardware (Screw and Washers) x2 or x4, Removed from
Drive Units and then Re-installed

B

Rear Sensor

E

Front Sensor

C

Rear Sensor
Bracket

F

Front Sensor Bracket

!

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers should stay at least 30 cm (12 inches) away from the underside of the Platform.

Single- and Dual-Sensor Installation, Part 1

1. Remove the side covers on both sides of the platform.
2. Remove the payload structure to expose the payload bay and the core.
The specifics of what is involved with this step depends on your payload structure.
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3. Tip the AMR onto its left side.
4. Attach two cable-tie anchors in the area behind the right drive wheel, as shown in the
following figure.

Figure 9-2 Cable-tie Anchors Behind Right Wheel
Proceed with either Single-Sensor Installation or Dual-Sensor Installation, and then perform the
steps in Single- and Dual-Sensor Installation, Part 2 on page 132.
Single-Sensor Installation

A single sensor goes in the forward position of the AMR.
1. Remove two M5 stainless socket-head cap screws, split lock washers, and flat washers
from the underside of the platform. See the following figure for the locations of the
screws.
Save the screws and washers for installation of the sensor.
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Figure 9-3 Screws to Remove, Circled
2. Attach the bracket to the underside of the AMR, with the cable between the bracket and
the platform. The sensor will already be attached to the bracket.
Use the M5 screws and washers previously removed. Use Loctite 243.
3. Route the sensor wires back to behind the right drive wheel, as shown.

Figure 9-4 Front Cable Route, Shown in Yellow
4. Install two cable-tie anchors to the underside of the platform, along the path of the
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cable.
5. Cable-tie the wires from the front sensor to the anchors.
6. Proceed to Single- and Dual-Sensor Installation, Part 2 on page 132.
Dual-Sensor Installation

1. Remove four M5 stainless socket-head cap screws, split lock washers, and flat washers
from the underside of the platform. See the following figure.
Save the screws and washers for installation of the sensors.

Figure 9-5 Screws to Remove, Circled
2. Attach the front bracket assembly to the underside of the AMR, with the cable between
the bracket and the platform. Its cable will be labeled FRONT.
The cable will have two branches, each attached to a sensor and bracket assembly.
Use the screws and washers previously removed. Install the M5 screws with Loctite
243.
The sensor will already be attached to the bracket.
3. Attach the rear bracket assembly to the underside of the AMR.
Use the M5 socket-head cap screws and washers previously removed. Install the M5
screws with Loctite 243.
The sensor will already be attached to the bracket.
a. Install two cable-tie anchors to the underside of the platform, between the two
bracket assemblies. See the following figure.
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Figure 9-6 Mounted Sensors
b. Cable-tie the wires from the front sensor to the rear to the anchors.
4. Proceed to the next section, Single- and Dual-Sensor Installation, Part 2.
Single- and Dual-Sensor Installation, Part 2

1. Route the sensor wires, both data and power, up through the platform chassis, just
behind the right drive wheel, and through the cutout shown in the following figure.

Figure 9-7 Cutout in Payload Bay for Cables
Cable-tie the cables to the anchors previously installed behind the right wheel. See Figure 9-2
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2. Put the AMR upright, and re-install the side covers.
3. Plug the splitter cable (Mini-Fit Jr™, included) into the AUX PWR port on the upper rear
core.

Figure 9-8 Upper Rear of Core, Showing AUX PWR Port
4. Plug the sensor power connector into one branch of the splitter cable.
This can power one or two sensors.
5. Plug the RS-232 connector(s) into the upper front of the core.

Figure 9-9 Upper Front of Core, Showing RS232 Ports
The front sensor plugs into RS-232-1.
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9.4 Installation on the LD-250

The rear sensor plugs into RS-232-2.
6. Reinstall the payload over the payload bay.

9.4 Installation on the LD-250

!

WARNING: MAGNETIC FIELD - MEDICAL IMPLANT RISK
Magnetic fields can be hazardous to medical implant wearers. Medical
Implant wearers should stay at least 30 cm (12 inches) away from the underside of the LD-250, which is exposed during certain maintenance procedures.

When cabling the HAPS sensors, refer to the LD-250 User's Guide for instructions that describe
how to remove and replace skins, the battery, and other components.
Required resources are:
l
l
l
l
l
l
l

Two people to lift the LD-250 onto its side.
4 mm hex driver for M5 socket head cap screws.
Small zip ties for cabling.
Self-adhesive zip tie mounts (dual HAPS, rear sensor only).
Blanket or padding to protect the LD-250 from damage.
Straps or other method of securing the LD-250 safely while tipped on its side.
Single or dual HAPS sensor kit.

If you are installing dual sensors, you also require the supplied splitter cable that provides
power to both sensor assemblies.

Preparing the LD-250 to Install HAPS Sensors
Prepare the LD-250 so that you can tip it on its side. This might require removing the payload
or the top cover skin, if installed. You must remove the E-Stop button from one side of the LD250 to prevent damage to the button.
1. Remove the front upper skin and the left and right side skins. (See: LD-250 User's Guide).
2. Remove the battery. (See: LD-250 User's Guide).
3. On one side of the AMR, remove the E-Stop button from its bracket as shown in Figure
9-10. Use your fingers or a flat-blade screwdriver to gently spread the prongs on the rear
side of the E-Stop (A) and remove the E-Stop latch button (B) from the switch body (C).
4. Unscrew the threaded locking ring (D) and remove the button from the AMR. Leaving
all cabling in place.
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Figure 9-10 Removing the E-Stop Button
5. It requires at least two people to complete this step. Put down a blanket or other protective surface, and tip the LD-250 on its side (A). Secure the LD-250 so that it cannot
move. Find the speaker assembly (B) toward the front of the LD-250 as shown in Figure
9-11.

Figure 9-11 LD-250 On its Side (A), Showing the Location of Speaker Assembly (B).
6. Use a 4 mm hex driver to remove the two pairs of M5 screws and washers [(A) and (B)
in Figure 9-12] that retain the loudspeaker assembly to its mount.
Carefully pull out the speaker assembly [(C) in Figure 9-12] until you can reach and disconnect both speaker wires.
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Figure 9-12 Removing the LD-250 Speaker Assembly.
You can now install and cable the HAPS sensors.

Install and Cable the HAPS Sensors on the LD-250
The instructions in this section show the procedure for both single and dual HAPS sensor
installation, If you intend to install only a single sensor, ignore the steps identified as (Dual
Only).
The photographs used in the procedure show additional components removed from the LD250. This is for clarity only, you do not need to remove any additional components at this
point.
As shown in Figure 9-13, The front HAPS sensor is located 302.4 mm (11.9 inches) in front of
the center line (E), while the rear sensor is located 204.6 mm (8 inches) behind the LD-250's
center line (E).
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Figure 9-13 Installation Location of HAPS Sensors on the Underside of the LD-250
Cable the sensors as follows:
1. Use a 4 mm hex key and the two supplied M5 socket head cap screws and washers to
install the sensor marked Front at location [(A) in Figure 9-13].
2. Route the cable as shown in Figure 9-14, over the bracket and up the side of the chassis,
adjacent to the caster mount.
Use a zip tie to secure the cable to the available cable tie mounts positioned on the
chassis, leaving no slack.

Figure 9-14 LD-250 Front HAPS Cable Routing Over the Sensor Bracket
3. Feed the cable behind the speaker mount as shown in Figure 9-15. Use a zip tie to
secure the cable to the available cable tie mounts positioned on the chassis, leaving no
slack.
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Figure 9-15 LD-250 Front HAPS Cable Routing Behind the Speaker Mount
4. Pass each RS232 connector (one at a time) through the oval hole in the side of the
chassis as shown in Figure 9-16. Feed the cable through, leaving no slack.
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Figure 9-16 LD-250 Front HAPS Cable Routing Through the Chassis
5. Pass the connectors up through the oval slot in the payload bay [(A) in Figure 9-17].

Figure 9-17 LD-250 Front HAPS Cable Routing Into the Payload Bay
6. Connect the front sensor's DB9 plug to port RS-232-1 on the upper front of the LD-250
Core [(B) in Figure 9-17].
7. Connect the Molex Mini-fit plug power to the user power connector on the back side of
the LD-250 Core [(D) in Figure 9-17].
8. (Dual Only) Use a 4 mm hex key and the two supplied M5 socket head cap screws and
washers to install the sensor marked Rear at location [(B in Figure 9-13].
Make sure that the sensor is facing forward, toward the front of the LD-250.
9. (Dual Only) Route the sensor cable as shown in Figure 9-18.
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Figure 9-18 LD-250 Rear HAPS Sensor Cable Routing Into the Chassis
Route the cable as follows, fastening it to cable mounts with zip ties and leaving no
slack in the cable.
Callout

Description of Cable Route

A

Behind the drive assembly, close to the chassis.

B

Over the caster mount.

C

Behind the drive motor.

D

Along the underside of the payload bay, close to the chassis (D).
Important: Place a self-adhesive cable tie mount in the center of this run to
prevent the cable from sagging.

E

Into the back of the speaker mount.

F

Pass each RS232 connector (one at a time) through the oval hole in the side
of the chassis.

10. (Dual Only) Pass the connectors up through the oval slot in the payload bay [(A) in Figure 9-17].
11. (Dual Only) Connect the rear sensor's DB9 plug to port RS-232-2 on the upper front of
the LD-250 Core [(C) in Figure 9-17].
12. (Dual Only) Connect the rear sensor Molex Mini-fit power plug to the other branch of
the power splitter cable [(D) in Figure 9-17].
To Reassemble the LD-250:
1. Reconnect the wires to the speaker assembly shown in Figure 9-11. (Terminals are sized
to prevent incorrect connection). Place the assembly in the mount.
2. Use a 4 mm hex driver to fasten the speaker assembly to its mount using two pairs of
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M5 screws and washers [(A) and (B) in Figure 9-12].
3. Two people can now tip the LD-250 back onto its wheels.
4. Referring to Figure 9-10, insert the button into its mount and tighten the locking ring (D)
to retain it in place. Push the switch body (C) onto the E-Stop button (A) until the
prongs (B) click into place. Pull on the switch body to make sure that it is connected.
5. Refer to the LD-250 User's Guide for instructions about replacing the skins.

9.5 Tape and Marker Application
The standard tape used is South facing up, with adhesive on North.
IMPORTANT: You cannot use the same marker tape configuration for both LD250 and for LD-60, LD-90 and LD-xxxCT models in hybrid fleets because of their
different sizes and turn radius.
To determine the distance between the LD platform and its final alignment goal (such as a
machine with which it interfaces) Refer to the LD model User's Guide to obtain the exact
dimensions of the platform.
For example, for the LD-60, LD-90 and LD-xxxCT models, the platform body is 499 mm wide.
In this case, setting a distance of 275 mm from the center of the tape to the intended conveyor
creates a gap of 25.5 mm between the AMR's side and the goal. If your payload has an overhang at the side, you must adjust the width accordingly.

72.1
(2.84)

A
C
L

697
(27.4)
B
C
L

A
C
L

165.5
(6.51)

499
(19.6)

C

D

Figure 9-19 Location of Front and Rear Sensors
LD-60, LD-90 and LD-xxxCT models (units are mm (inches))
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9.5 Tape and Marker Application

Key Meaning Key

Meaning

A

Sensing

C

Rear Sensor

B

Axle

D

Front Sensor

Apply markers 20-30 mm to the right of the main tape track. See the following figure.

F

G

A

B

E

400

30.0°

H

K

500

J

D

C

Figure 9-20 Two-stop System (units are mm (inches))
Key

Meaning

Key

Meaning

A

Goal 1 and Goal 2 (at some location)

F

Conveyor 1

B

Main Track

G

Conveyor 2

C

Rear Sensor

H

Marker 1

D

Front Sensor

J

Marker 2

E

Direction of Track

K

20-30 mm between main track and markers

If you use the same magnetic tape for markers as for the main tape strip, apply the markers
upside-down, relative to the tape. If you use tape with North up (rather than the South-up
tape) ensure that the markers are applied with their South side up.
The recommended marker length is 300 mm. Shorter markers can be used if the AMR is operating at slower than default speeds (< 500 mm/second).
The AMR will stop with the front sensor at the front end of the marker. Note the modeldependent locations of the sensors to calculate where you should place the markers in relation
to the location where you want the AMR to stop.
NOTE: Even if you drive backward to reach a marker, the AMR will intentionally overshoot, and then drive forward to align its front sensor with the front
of the marker. You should extend the markers at least 40 mm past the goal to
enable the AMR to reacquire the goal if it overshoots.
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Define Goals
An AMR with front and rear sensors needs 500 mm of tape for alignment.
Each marker needs its own goal. A suggested goal location is 400 mm from the tape, near the
start of the tape, with an orientation of 30° from the angle of the tape. This allows the AMR to
approach the tape at normal speed without overshooting it. If you use a sharper angle, aimed
more directly at the tape, you need to reduce the AMR‘s ApproachSpeed to prevent overshoot.
See the preceding figure and Robot Operation on page 143. Goal 1 would apply to Marker 1,
Goal 2 to Marker 2.
For multiple markers, all goals should be placed at the same location. Each goal will contain
the tasks associated with one marker.

9.6 HAPS Software Configuration
The HAPS parameters are configured using the MobilePlanner software.

Robot Physical
1. Go to:
MobilePlanner > Config > Robot Physical
2. Check the Show Expert + Parameters check box.
3. For GuideSensor_Front:
a. Check the AutoConnect check box.
b. Set the Port parameter value to /dev/ttyUSB9.
4. For GuideSensor_Rear, when a second sensor is present:
a. Check the AutoConnect check box.
b. Set the Port parameter value to /dev/ttyUSB10.

Robot Operation
1. Go to:
MobilePlanner > Config > Robot Operation
2. Check the Show Expert + Parameters check box.
3. Select the FollowGuide entry in the Sections pane.
l

l

l

l
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ApproachSpeed is the speed, in mm/sec, to drive when approaching the tape
from the goal.
FollowingSpeed is the speed, in mm/sec, to drive while following the tape.
ReverseFollowingSpeed is the speed, in mm/sec, while following the tape in
reverse. Maximum is 300 mm/second. This only applies for a second sensor.
SlowCaptureSpeed is the speed, in mm/sec, to drive after deceleration when
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finding the end of a marker. This should be slow, such as 20 mm/sec.
l

followingAccel is the acceleration to use. 0 means default.

l

followingDecel is the deceleration to use. 0 means default.

l

FrontClearance is the minimum distance to an obstacle in front of the AMR
before the AMR will stop. It should leave room to path plan away.
This needs to be small enough so the AMR does not stop too soon when
approaching a conveyor or other fixed object that you want it to approach
closely.

l

SideClearance is the minimum distance to an obstacle on either side of the AMR
before the AMR will stop. It should leave room to path plan away.
This needs to be small enough so the AMR doesn’t stop too soon when approaching a conveyor or other fixed object that you want it to approach closely.

l

AvoidLocationDependentObstacles will avoid map obstacles like forbidden lines
and areas, if True.

Goals/Tasks
The two tasks relevant to the HAPS option are FollowGuide and Engage.
NOTE: In this context, a goal is a goal on the AMR’s map. It is used as a starting point for tasks that will drive the AMR along the tape, stopping at markers
along the tape. There will be no goals on the tape itself.
The FollowGuide task has the following parameters:
l

successCriteria
This will usually be captureMarker, to stop at a marker. It is possible to use either end
of the tape, if two sensors are present, but markers offer more flexibility.

l

markerNumber
Which marker on the tape the AMR will stop at.

l

markerLength
Physical length of the marker. 300 mm is typical.

l

acquireTrackAfterMarker
Where the AMR will enter the tape, relative to the markers on the tape. This is determined by the location and angle of the goal, relative to the tape and markers. Normally,
this will be 0, meaning the AMR will enter the tape before any markers.

The Engage task calls a macro when the AMR arrives at the goal, so the AMR can be sent on a
series of tasks, such as a FollowGuide task to go to a marker.
If successive goals are at the same location, and each has the Engage task on it, the AMR can
be sent on multiple tasks without returning to the goal location. This allows you to have the
AMR go to multiple markers without ever leaving the tape to return to the goal location.
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l

Each marker needs its own goal.

l

Each of the goals needs to be at the same location.

l

Each of the goals needs to have the Engage task.

l

Each of the Engage tasks will have a different engageMacro.

When a goal’s engageMacro finishes, if the next goal assigned to that AMR is at the same location as the previous goal, and has the Engage task, the AMR will not drive back to the goal,
but instead will start executing the engageMacro associated with the new goal.
The parameters associated with the Engage task are:
l

l

l

EngageMacro = A macro, generally containing the FollowGuide task, that tells how to
get to the correct spot on the tape.
DisengageMacro = A macro that tells the AMR how to remove itself from the tape safely
from that marker position. If no macro is given, the robot will go to autonomous mode
automatically.
UseGoalPosition = How close goals need to be for them to be considered as being at the
same location. A tolerance larger than the distance between the goals will make it so
that the goals are considered as being at the same location. After entering True for this
value, you will be given a choice of distance. The defaults are generally fine.
Note that this is the goal position, and not the position that will result after the FollowGuide or Engage tasks.

l

FaultEngageMacro = How the robot will deal with failures when engaging.

l

FaultDisengageMacro = How the robot will deal with failures when disengaging.

l

EngageOnlyIfFromGoal = Set to False or blank when using FollowGuide.

l

l

lockModeduringMacro = Boolean to decide if the robot’s mode will be locked during the
engage process.
whenEngagedSupress = Choose to suppress the goal driving, so the AMR doesn’t drive
back to the goal location between goals.
Do not set this to suppress macros, as they are needed to use the engageMacro of each
successive goal.

9.7 Specifications
Feature

Specification

Sensor
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Depth

30 mm

Width

160 mm

Rating

IP64

Environment

-40 to 85° C

LEDs

Power, Tape present, Left marker, Right marker
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Feature

Specification

Magnetic Tape
Width

25 mm

Orientation

South up

Markers (Magnetic Tape)
Width

25 mm

Length

300 mm min. for 500 mm/sec drive speed

Orientation

North up

Separation from tape 20 - 30 mm
Connections
Front sensor

RS232-1 (/dev/ttyUSB9) on the core

Rear sensor

RS232-2 (/dev/ttyUSB10) on the core

Power, both sensors

Aux Power, using the included splitter cable

9.8 Dimensions

B

A

Figure 9-21 Overall Dimensions of the Sensor, (A) Top View and Dimensions, and (B) Front View and
Dimensions (units are mm)
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